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Getting Started with General Operations

Within our documentation, some content might be specific for cloud deployments while other
content is relevant for on-premises deployments. Any content that applies to only one of these
deployments is labeled accordingly.

Primavera Unifier is a project lifecycle management solution for capital planning, project delivery,
cost control, and facilities and real estate management. Unifier provides governance across all
project phases, from planning and building to operations and maintenance.

There are two modes of operation:

» User mode 'E}':

Used to enter and access information and perform tasks. Most users do their work in User
mode. The User mode allows users to perform day-to-day activities, collaborate through
business processes and Mailbox, maintain managers (for example, Cost Manager, Schedule
Manager, and Document Manager), and run reports.

» Admin mode %:

Used for all administrative tasks to set up and configure features and modules. Access to
Admin mode functions is usually limited to a few users within a company. Company
administrators work in Admin mode to set up, for example, company and project or shell
properties, user permissions, templates for major features, data structures, and configure
and set up business process (BP) workflows.

You can switch between modes using the mode icon
Note: The instructions and information presented in the Unifier

documentation is based on an out-of-the-box setup and before being
customized by the user.

Permissions (Access Control)

The ability to utilize a specific function depends on the Permissions Settings (accessed in
Admin mode). At the Company Workspace (company level) > Admin mode > User
Administration > Access Control functional node, you can access permission settings for:
» Administration (Admin) mode access
» User mode access

Access to system functionality is granted through Access Control or Permissions.
Note: This option is not available in Home workspace because the
Home workspace does not support the Admin mode.

The Unifier user guides are:

» Unifier General User Guide
» Unifier Shells and Projects User Guide
» Unifier Business Processes User Guide
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» Unifier Managers User Guide
Each user guide explains how to use specific parts of the application.

This guide explains how to work with Unifier and covers a range of topics, such as what you
need to know the first time that you use the system, security guidelines, reports, and using the
mobile application.

In This Section
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About Consent Notices (Users)

Consent notices alert you to the need to protect personal information (PI). You and your
organization might be collecting, processing, storing, and transmitting P1. When you accept a
consent notice, your consent covers the collection, processing, storing, and transmission of Pl
data in all areas of Unifier and means of retrieving data from Unifier including but not limited to
project export, downloaded tables, reports, documents, web services, API, and Unifier. If you
refuse consent you might not be able to access some areas of Unifier.

You may be asked to provide consent to show that you understand the need to treat Pl as
secure data. You may also be asked to provide consent for your organization to collect, process,
store, and transmit your PI. If you refuse consent you will be denied access to Unifier.

Cookies Policy

When using Unifier, the server may generate cookies and send them to the user's browser. The
user's machine stores the cookies, either temporarily by the browser, or permanently until they
expire or are removed manually.
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Each user that signs in to Unifier web will see a notification banner (Cookies in Unifier) that
notifies the user that Unifier uses cookies. This banner has a link to the Unifier cookie policy
which explains what information is being tracked by way of cookies. The user must click Got It to
access the rest of the Unifier application.

Oracle might use cookies for authentication, session management, remembering application
behavior preferences and performance characteristics, and to provide documentation support.
Also, Oracle might use cookies to remember your log-in details, collect statistics to optimize site
functionality, and deliver marketing based on your interests.

For more information on Oracle's data collection processes and privacy commitments, see:

Oracle Cloud Services Agreement
http://www.oracle.com/us/corporate/contracts/saas-online-csa-us-1894130.pdf

Oracle Privacy Policy
https://www.oracle.com/legal/privacy/services-privacy-policy.html

Oracle Data Processing Agreement
https://www.oracle.com/corporate/contracts/cloud-services/






Product Accessibility Information

This topic includes guidelines and tips regarding accessible product usage.

Keyboard Shortcuts

The list of keyboard shortcuts for Oracle Primavera Unifier and Oracle Primavera Portal (access
point for your Oracle Primavera applications), including page-specific and browser-specific
keyboard shortcuts, can be accessed in the Navigating the System Using a Keyboard (on
page 11) topic.

Common Symbols, Icons, and Tabs: What to Expect

The following are common symbols, icons, and tabs in the application and what they signify for
the user.

Asterisks

An asterisk (*) after a column or field name indicates that the field is required. The field must be
populated with valid information or users will encounter an error.

In This Section

Navigating the System Using a Keyboard .................eeuueeiiiiiiiiiiiiiiiiiiiiiiieiiiiiinieeennnns 11

Navigating the System Using a Keyboard

You can use your computer keyboard to navigate throughout the system. Use the Tab key on
your keyboard to cycle through elements within the application and press the Enter key on your
keyboard to access them. Use the application keyboard shortcuts to access frequently used or
important functionality.

Note: The keyboard shortcuts might change depending on the browser
that you use.

Main Content Area

Use Ctrl and + or Ctrl and - to zoom in and zoom out anywhere in the application.

Use the Tab key on your keyboard to highlight the toolbar buttons and press Enter to make the
action applicable.

Grids

A grid contains content rendered in a tabular format. Any grid has a similar method of
interaction. Grids are extensively used in places such as the logs (for example: Business
Process Record log, Line Item list, Document Manager log, Cost Manager log, Mailbox, and so
on), Sheets (for example: Cost Sheet, Funding Sheet, Cash Flow worksheet, Activity Sheet,
Portfolio Manager Sheet, and so on).

11
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Only the rows that are visible are rendered. As you navigate up and down the table, more items
will be visible.

To enter the table, tab to it. Tabbing to the table will cause an overlay to be displayed with the
message Press tab to skip over this widget. Press Enter, Esc or click to enter the grid.

Use Arrows or Tab and Shift + Tab to navigate through the table. To move focus to another cell
when you reach the end of the row, use the Arrows or Shift + Tab.

Editable Grid

Any grid that has editable content has a similar method of interaction. Examples of such grids
are the Line item grids seen in business processes, manual entry columns in Cost Sheet, and so
on.

Press F2 or Enter to put the cell in edit mode.

To select a value from a list of values (from the fields of type Pull Down, navigate to the cell by
tabbing, and press F2 or Enter. Use the Up and Down Arrows to highlight an option. Press Enter
to select the option.

To select a value from a calendar picker (from the fields of type Date and Date Only pickers),
navigate to the cell by tabbing, and press F2 or Enter. Use the Tab key to change the Month and
Year selection and use the Up and Down Arrows to highlight an option. Press Enter to select the
option.

Individual Web Elements

Hyperlink Fields

1) Tab to enter into the Hyperlink field.

2) Press Enter to view the Hyperlink field attributes.

3) Tab to the Name field and enter your choice.

4) Tab to the URL field and type in the URL.

5) Tab to access the Clear, Cancel, or Done options.

6) Press Enter to select choice and close the hyperlink field.

Pull-Down

1) Tab into the cell.

2) Press Enter.

3) Use Up and Down Arrows to highlight the option.
4) Alternatively, type the value.

5) Press Enter to select the option.

Picker

1) Tab into the cell.

2) Press Enter.

3) Type a value for the Display Element.

4) Press Up and Down Arrows to highlight choice.

12
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5) Press Enter to select choice and close picker.

Multi Select Input fields

Option 1:
I. Tabinto the cell.
2. Press Up and Down Arrows to highlight choice.
3

Select your choice.
4. Press Enter to select it.

Option 2:
Tab into the cell.
Type a value.

Press Up and Down Arrows to highlight choice.
Press Enter to select it.

A w N -

Date Picker fields

Option 1:
I. Tabinto the cell.
2. Type the date in the format specified.
3.

Press Enter.
4. Tab out of the cell.

Option 2:
Tab into the cell.
Use the Up, Down, Left, and Right arrows to select a value.

Tab to select the Action button.
Press Enter.

W -

Number Fields
|. Tabinto the cell.
2. Enter the value.
3. Tab out of the cell.

Text Fields
I. Tab into the cell.
2. Enter the string.
3. Tab out of the cell.

Using Shortcut Keys

The following tables list the menu options that have shortcut keys. If an option is not listed, it
does not have a shortcut key.

13
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Function Keys Supported in Unifier

Command Function Key
Reload / Refresh F5
Close browser windows Alt + F4

Hot keys Supported in the Editable Grid of Unifier

Command Hot Key
Select All Ctrl A
Cut Ctrl X
Copy CtrIC
Paste Ctrl vV
Undo Ctrl z
Redo CtrlY

Keyboard End User Information (oj-navigation-list)

The following table explains the user information for oj-navigation-list:

Target Key Action
List Iltem Enter or Space Selects list item.
Up Arrow Moves focus to the previous
visible list item.
Down Arrow Moves focus to the next

visible list item.

Right Arrow (Left Arrow in
RTL)

For horizontal navigation list
and focus will be moved to
next visible item.

Left Arrow (Right Arrow in
RTL)

For horizontal navigation list
and focus will be moved to
previous visible item.

Home Moves focus to the first
visible list item.

End Moves focus to the last
visible list item.

F2 If focus is on a list item,

pressing F2 will make its

14
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Target

Key

Action

contents accessible using
Tab.

Esc

When F2 mode is enabled,
press Esc to exit F2 mode.

Shift+Tab

Move focus to hierarchical
menu option. This is only
applicable for sliding
navigation list and when
hierarchical menu option is
enabled.

Group Item

Right Arrow (Left Arrow in
RTL)

If focus is on collapsed
node, expands the sub list.

Left Arrow (Right Arrow in
RTL)

If focus is on expanded

node, collapses the sub list.

List Item in sublist

Esc

Applicable only for sliding
navigation list. If focus is in
a sublist, it closes the
sublist and moves focus to
the parent list item.

Hierarchical Menu button

Enter

Open menu. Refer to the
menu keyboard
documentation. This target
is visible only for sliding
navigation list.

Tab

Moves focus to current list
item. This target is visible
only for sliding navigation
list.

Shift + Tab

Moves focus to Previous
Icon. This target is visible
only for sliding navigation
list.

Overflow Menu button

Enter or Space

Open menu. Refer to the

This is applicable only for
horizontal navigation list
when overflow is set to

pop-up.

menu touch documentation.

Previous Icon or List
Header

Enter

Collapses the sublist and
slides to parent list. This
target is visible only for

15
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Target Key Action
sliding navigation list.
Tab Moves focus to Hierarchical

Menu option. This target is
visible only for sliding
navigation list.

16




Information for First Time Users

You need to have Administrator privileges, on the local machine, before you can configure your
computer for use with Unifier and install certain plug-ins. Always review this information with
your IT department.

If you receive a message regarding the Base Currency for the company the first time that you
sign in, click OK and contact your Company Administrator. The Base Currency is the default
currency used by the company. Although it might be set by Oracle when the system is first
provisioned, the Base Currency must be selected the first time that the Company Administrator
signs in. No other users are allowed to sign in until the Company Administrator sets the Base
Currency.
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Configuring Your System for Unifier

Ensure that the necessary browser settings (within the supported browsers) are configured for

the computers that access Unifier. For the full list of system requirements and versions, refer to
Unifier Tested Configurations (on-premises only) or Unifier Client System Requirements (cloud
and on-premises).
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Supported Browsers and Settings

You can use Primavera Unifier with the following supported browsers:

» Microsoft Edge
» Mozilla Firefox
» Google Chrome
» Apple Safari

Notes:

= For the full list of system requirements, supported software, and
versions, refer to the Unifier Tested Configurations and the Unifier
Client System Requirements documents.

= For additional information about plug-ins, go to:
https://www.java.com/en/download/help/enable_browser.xml, or
https://www.java.com/en/download/fag/chrome.xml.

Microsoft Edge

Refer to Microsoft Edge Help to see the details on language settings and how to set up the
options explained here.

Mozilla Firefox

Refer to Mozilla Firefox Help to see the details on language settings. If your internet settings are
customized, contact your IT for more information. When finished, sign out of the application and
close the browser completely in order for the new settings to take effect.

For plug-ins, follow these steps:

1) Open the Firefox browser, or restart it if it is already running.

2) From the Firefox Menu Bar, select Tools, then click Add-ons.

3) Inthe Add-ons Manager window, select Plugins.

4) Select the Java (TM) Platform plug-in (Windows) or the Java Applet Plug-in (Mac OS X).
5) Ensure that the option "Ask to Activate" or "Always Activate" is selected. For older

versions of Firefox, click Enable. Note that if the button displays Disable, Java is already
enabled.
Google Chrome

Refer to Google Chrome Help to see the details on language settings. If your internet settings
are customized, contact your IT for more information. When finished, sign out of the application
and close the browser completely in order for the new settings to take effect.

Note: AutoVue viewing is not supported in Google Chrome.

Apple Safari
Refer to Safari Help to see the details on how to set up the options explained here.
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To use Apple Safari, open the browser preferences and set Java to run in unsafe mode. Go to
Preferences, under Security select Java, then select Run in Unsafe Mode, and click OK.

For plug-ins, follow these steps:

1) Click Safari and select Preferences.
2) Select the Security option.
3) Select Allow Plug-ins, and then click Manage Website Settings.

4) Click the Java item, and select one of the options: Ask, Allow, or Allow Always (from the
drop-down list When visiting other websites).

5) Click Done and close the Safari Preferences window.
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User Interface (Ul) Content and Internationalization

The contents that appear in the application Ul (also known as System Strings) cannot be
modified by the Users. The System Strings are available in different languages, per user
preferences.

Example

Sign In and Terms and Condition pages, Menus, Alerts, and Errors
In contrast, the content of the material created by the Users (also known as Custom Strings) can
be translated into different languages. For more information, see Translating Custom Strings
(Internationalization) in the Unifier General Administration Guide.

Example

Business Process (BP) name, Data Element (DE) label, pull-down values, radio button, text
in lines, navigation log names, and multi select values

Notes:

= The user input data (data entry) in Business Processes (BPs),
attribute forms of various managers (Cost Manager, Document
Manager, and so on), and other similar elements, when entered at
runtime, cannot be translated.

= User's data entry must be saved “as-is” and include support for single
and multi-byte characters UCS Transformation Format—8-bit
(UTF-8).

For more information, see Internationalization.
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User Name and Password

Before you can sign in to Primavera Unifier, you must have a user account, which will provide
you with a Login Username and a Password that you can use to sign in to the system. Your
Primavera Unifier Company Administrator(s) should be able to create your user account and
provide you with your Login Username and Password.

Note: If Oracle Primavera Customer Support Team is administering the
setup and user administration for your company, you will receive your
Login Username and Password directly from them.

Sign in for the First Time
To sign in to the system for the first time:

1) Enter username and password.
2) Click Sign In.
3) Click Accept in the Consent Agreement.

The Password Recovery secret questions setup form is displayed.

To setup the security questions, if the system redirects you to the security setup form:

Note: You would see a blurred background of the last instance before
logging off if you logged in earlier but did not setup the security
questions.

1) Inthe password recovery form, select the questions and enter the answers to the mandatory
fields.

2) Click Save to save the entered values.

3) Click Done to exit the form. You are brought back to the instance that you were in before
logging off.

4) Alternatively, click Sign out to exit the form if you do not want to setup the security
guestions.

To determine whether the company policy makes it mandatory for you to set up the password
recovery secret questions:

1) In the upper-right corner, click the user control panel.

2) Click Preferences.

3) Click Security.

The password recovery secret questions are marked as required fields with the selected
guestions and the answers provided at the time of login.
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Note: The answers are masked.

Forgot Password (on-premises only)

You can reset your own password by answering security questions, if this option is made
available to you by the Administrator.

Note: Enabling the user to use security questions to reset password
must be done by the Administrator at the company level. Oracle
recommends that the Administrators set up security questions so users
can reset their own passwords.

If the option to use security questions to reset password has been made available, then the
system directs you to the setup page to enter your security questions and proceed with changing
your password.

If the option to use security questions to reset password has not been made available, then the
system does not direct you to the setup page. In this case, you must contact your Administrator
to request password reset.

To reset your password:
1) Inthe Sign In window, click Forgot Password.

2) Enter your user name and email address, and click OK.

3) Answer your Secret Question(s) and click Submit. You will receive an email notification
containing your reset password. Use the new password to sign in.

To add secret questions to use when resetting your password:

1) Sign in to the system, then click the Preferences link in the upper right portion of the
application window.
2) Click the Security tab.

3) Under Password Recovery Secret Questions, select a question and enter the answer. You
can add up to three Secret Questions.
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Sign In, Sign Out, and Session Timeout

To sign in
1) Open your browser and enter the web address that your site administrator has provided for
you.

The Sign In page appears based on the supported browser language. If the browser is not
supported, the Sign In page appears in English.

2) Enter your user name.
3) Enter the password that was set for you during installation.
4) Click Sign In to open the application.

Notes:
= After signing in, the language will be based on the Language selected
in the Preferences. See Preferences (on page 61) for details.

= [f you receive a message regarding the Base Currency for the
company the first time that you sign in, click OK and contact your
Company Administrator. The Base Currency is the default currency
used by the company. Although it might be set by Oracle when the
system is first provisioned, the Base Currency must be selected the
first time that the Company Administrator signs in. No other users are
allowed to sign in until the Company Administrator sets the Base
Currency.

If you have trouble signing in, check to ensure that:

» The Caps Lock function is not on (user names and passwords are case-sensitive).
» You entered the correct user name and password.

If you still have trouble signing in, contact your Company Administrator or Oracle Customer
Support.

After signing in for the first time, you may want, or be required, to change your password.

Note: Save your work often.

To sign out
1) Click your user name to open a contextual menu.
2) Click Sign Out from the upper-right corner of the application window.

Session Timeout
The system displays a warning after five minutes of inactivity: Session Inactive.

» If you click Stay Signed In, then your session will remain active. This applies to sessions
running in other browser tabs.
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» If you do not respond, or if you are inactive for more than five minutes, then the system will
terminate your session and display an alert: Your login session may have expired due to
inactivity.

When your session expires, the system redirects you to the sign in page if there are no active
sessions running, or there are inactive sessions, in other browser tabs.
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Signing In to Self-Service Portal

Portal Users

Portal users can access the Unifier website and Portal website. After the Portal user logs in, the
Portal landing page is displayed.

Self-Service Portal

Certain business processes can be enabled for access through the Self-Service Portal. The
actions users can take through the Self-Service Portal are:

» Create a business process

» Modify a business process

» Add or remove business process attachments
» Add General Comments to a business process

Sign in to the Self-Service Portal
To sign into the Self-Service Portal Landing Page:

1) Inyour web browser, enter the URL you use to access Primavera Unifier, followed by /portal.
For example: https://your-web-address.com/portal

2) Enter your Self-Service Portal user name and password.

3) Click the Sign In. The landing Page opens.

Note: You must have the proper permissions to use the options
indicated below.

Self-Service Portal Navigation
The Portal has a fixed Home tab along with Portal Business Processes (BPs) tabs.

» You can re-sequence the tabs through drag-and-drop.
» Unifier retains the last saved tab sequence.
» You cannot close the tabs.

To open or edit an existing record:
1) Click the business process tab. The business process log opens in the right pane, listing all
available records that you have permission to view.

2) Select the record from the log and click Open (or double-click the record from the log.) The
record opens in the view-only mode.

3) To edit the details, click Edit.
4) To submit the edited record, click Submit.
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Note: You must have the proper permissions to create, view, or edit
portal-enabled records.

Self-Service Portal Home Page (Landing Page)

If your administrator has setup an active (Home) landing page, then the active (Home) landing
page is displayed. If your administrator did not setup an active (Home) landing page, then a
system-provided Home landing page is displayed. The system-provided Home landing page has
the following attributes:

4
4
4

This page contains pie-charts for each of the BPs.

The pie-chart has status-based colors corresponding to the status of the BP.

If there are no records for a given portal BP, then an informational text is displayed. Under
each pie-chart a grid is displayed that contains the Record Number, Title, and Status
information.

Only the top five records are displayed, in descending order, based on the last updated date.

You cannot open the record from the grid. When you click the pie-chart, the system opens
the respective BP tab.

Note: All the Portal enabled BPs will get a tile on the Portal landing
page, based on user permission. If there are more than 3 BPs, then the
system displays a scroll-bar for viewing more tiles. The order of tiles is
determined by the most recently updated BP records.

Self-Service Portal Business Processes Log (Master Log - Business Processes Grouping
Node)

The log enables you to see the records and conduct the following:

30

Create: To create new records.
Actions: To select the following options for bulk selection of records:
» Bulk Edit: This option is displayed if you have the permission.

» Print: Provides user the ability to print multiple records as per the selected format
(HTML, PDF, and Custom)

» Transfer Ownership: Transferring the ownership to another user. This option is available
if you have the "Modify Ownership" permission.

» Terminate Record: Terminating a record. This option is available if you have the
"Terminate Workflow" permission.

View: To see the views that have been defined in Business Process Configuration. For
example: All Records, Records Created by Me, Create New View, and Manage Views.

Edit View ( Z ): To edit the view settings.

Refresh ( G ): To refresh the items on the page.
Print: To print the log content, Export to CSV, or Export to Excel.
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Notes:

= For export to Microsoft Excel, the system currently supports only Euro
(EUR) and United States Dollar (USD) currency symbols.

= |f you export data from a business process (BP) record, sheet (such
as an Activity Sheet), or log (such as Company Funding Sheet Log)
to Excel, be aware that depending on how your negative values are
formatted, you might need to configure your columns in Excel to
match the correct data type (Number). Otherwise, the columns will
not be treated as numeric and will not sum as expected. One
supported format includes placing the negative sign between the
currency symbol and the amount (for example, $-1,000).

» Search ( Q): To open the Search window and search the log based on pre-defined
uDesigner search fields.

» Find Page ( 52 ): To conduct a search within the displayed page content.

» Help (®): To view help options.

The gear ( % ) menu, displayed in front of each record when hovering over the record, enables
you to:

Open: To open a record.

Copy with Attachments: To copy a record.

Copy without Attachments: To copy a record.

Print - HTML: To print a record.

Print - PDF: To print a record.

Print - Custom: To print a record.

Transfer Ownership: To transfer the record ownership to another user. This option is only
available when the user has "Modify Ownership" permission.

» Terminate Record: To terminate a record. This option is only available when the user has
"Terminate Workflow" permission.

v v vV v v v Vv

When you select a record, the log displays a pane on the right side of the page. Use this pane to
see the record details and attachments by using the following tabs:

» Record Details
» Attachments

Self-Service Portal: Creating and Submitting a New Record (Existing Users Only)
1) Select a business process to work with from the log in the left Navigator.
2) Click New.

Note: The New option displays if this element is designed in Unifier
Configuration. If not, you need to click Create, as explained below.

3) Fill out the business process form.
4) Click Submit.
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Self-Service Portal: Preferences (User Preference)
The Preferences window enables you to enter specific information by using the following tabs:
» General

The Personal Information contains only the First Name and Last Name fields.

» Security
Some of the options are not available for cloud customers.
» Email Subscription
This option is not available in Self-Service Portal.
Region Format
Proxy
This option is not available in Self-Service Portal.
» More
See Preferences (on page 61) for additional details about the Preferences window.
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Security Warnings

The first time you perform certain functions in the system, security warnings may appear from
third party software confirming the use of Java plug-ins from these business partners.

Follow the instructions below to prevent the warnings from recurring every time that you use the
functionality that requires these certificates.

Preventing a Security Warning from Recurring

A first time user may receive a security warning. When prompted by your browser to
acknowledge a security warning, you may select your browser option to ignore future warnings.
The setting to ignore warnings varies by browser.
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File Viewer Option

The following topics discuss the basic user preferences settings that should be configured
before using the system for the first time.

For more information regarding all Preferences settings, see Preferences (on page 61).

File Viewer Option (Select Default Viewer)
There are two methods of viewing files:

» Native

» Unifier Viewer

Unifier Viewer is the default option. The Viewer lets you view and markup documents. The
markups are saved as markups without changing the original file. Native Viewer allows you to

view most file formats in the application in which you created or regularly view them. In other
words, if you view a .doc file in Native, Microsoft Word will open and display the .doc file.
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Unifier User Interface

The user interface has both static and dynamic elements.

The following image displays the static elements of the user interface, and the explanation for
each static element follows.

Unifier User Interface Header
The header section of the interface contains the following elements, from left to right:

» Unifier logo (Primavera Unifier)
Application name and environment.

» Announcements (megaphone icon )
Enables you to view company-wide announcements. The announcements are sorted by
Title, Date (creation date (Latest at the top), and Announced By.

When a new announcement record is unread, a red bubble count-indicator icon (E)

appears on top of the gray announcement icon (the megaphone icon). In the bubble icon, the
number of unread announcements is displayed.
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When there are no unread announcements, the bubble count-indicator disappears.

When you click the announcement icon (the megaphone icon), a grid appears that displays
all of the unread announcements, highlighted in red. All the announcements are displayed in
descending order, according to the date.

After an announcement record has been read by a user, the title of the record is displayed in
black.

Bookmarks (E)
To bookmark a page. See Bookmarks (on page 80) for details.

View Help Menu (question mark icon @)
The View Help Menu has a contextual menu that enables you to access the following:

4

User Help

To access the User Help.

Admin Help

To access the Administrator Help.
uDesigner Help

To access the uDesigner Help.
Unifier Library

Download Plugins

The Support window has two tabs:
Contact

Download (opens by default)

For information about the Contact tab, read the topic: Contact Support.
Download tab

In the Download tab, you can see the following plug-in and applications. These plug-in
and applications are available to download. A link to the installation instructions is
available, where applicable.

AutoVue WebStart
Follow the links within each option to proceed.

Customers are requested to use REST services. The Web Service Description Language
(WSDL) document can be provided by making a Service Request.

Contact Support

The Support window has two tabs:
Contact (opens by default)
Download

In the Contact tab, Contact Information section, you can see the name, phone, and
contact instructions of someone at your company that you can contact when you need
help. For assistance, try this person first.
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Note: This information is available only if your company administrator
has provided internal support contact information.

In the Contact tab, eLearning section, you see the location (Access), name of the
contact (Contact), and any instructions that you might need in order to access the
elLearning materials.

Note: Your company may elect to provide access to the eLearning suite,
where you can access interactive learning materials. Alternatively, your
company may have its own customized support or training materials that
can be accessed on an internal site/location. If your company
administrator provides this contact information, it will be listed at the
bottom of the window.

About Unifier

Click to access:

Version number

Copyright information

Software agreement details for Primavera Unifier
Cookie Policy

Privacy Policy

» Name of the user

Displays the name of the person who has signed in, and if you click the name, you will be
able to access the following features:

4

Get Unifier Mobile Help

Enables you to open a new window and proceed to download the Unifier Mobile App.
Follow the instructions on this window to get the app for both Android and iOS.

Preferences
Click to open the Preferences window. The Preferences window has the following tabs:
= General tab
= Security tab
= Email Subscription tab
* Region Format tab
= Proxy tab
= More tab
See Preferences (on page 61) for details.
Change Password
Enables you to open the Change Password window.

Note: The Change Password option is only visible for on-premises
customers, not for cloud customers.

See Change Password (on page 79) for details.
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» Proxy For

Click to expand the menu and see the list of individuals who selected you as their proxy
and sign in as that person's proxy.

See Proxy For (on page 79) for details.
» Lastlogin: MM/DD/YYYY HH:MM AM/PM
The date and time when you signed in last.
» Sign Out
Enables you to sign out of the system.
See Sign Out (on page 79) for details.

You may see the Upload Status icon ) appear next to the Announcements icon. This
happens when there are documents pending to be uploaded. In general, when you go to the
Document Manager grouping node (for example, Company Workspace or Administration
tabs > Document Manager where you can upload multiple documents), you can see the
Upload Status icon on top. The color of this icon changes depending on the upload status. You

can click Clear to remove this icon.
Unifier User Interface Location Bar
The location bar at the top of the interface contains the following elements, from left to right:

Notes:

= One page or tab must always be present.

= On touchscreen-enabled devices, the close button (x) is displayed for
every page or tab in the location bar at the top of the application,
instead of being displayed only for the active page or tab.

Analytics Kl page or tab

Home 0O workspace
Company Workspace page or tab

Switch-to tab (arrowhead icon v ) allowing you to switch to a different tab)

v Vv Vv v Vv

New tab (plus icon =+ )to add a new tab (shells or projects) to the location area)

Creating new tabs is useful when navigating to frequently used locations, such as the
Company Workspace, shells, or projects. You can create an unlimited number of tabs that
can be rearranged by clicking and dragging, or removed by clicking the X that appears when
hovering over a tab. You can remove all tabs except for the Home workspace and the
Analytics tab.

When creating a new tab, the location launcher window displays three sections - Recent
Locations (recently accessed locations), Key Locations (Company Workspace and
single-instance shells), and Bookmarks (locations you have saved in Bookmarks. The height
of the initial drop-down dynamically varies based on the number of items in Key Locations.

Use the search bar to quickly find a location. Alternatively, click the location picker icon ( *# )
to see the log of all available locations to choose from.
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You can also create multiple tabs representing the same location to quickly navigate to, or in,
different areas within that location.

Tabs maintain their states if you switch tabs. For example: If you are working in Schedule
Manager (User mode) and decide to switch to another tab and switch back, the system
preserves your view and settings in the Schedule Manager node for when you return.
Similarly, when you sign out and sign in again, you return to the tab that you were working
with, before you signed out, with your settings preserved.

Note: First-time users see only the Home workspace. Returning users
see all the tabs that were displayed in the previous version.

Unifier User Interface Left Navigation

The left Navigator (also known as the left Sidebar or left Navigation) lists all the nodes that are
available for a company, shell, or project.

Note: Your Navigator setup may differ, but the basic functionality will be
the same.

Your company administrator can configure the User Mode Navigator (Company Workspace >
Admin mode > Configuration > User Mode Navigator) to better suit the company business
needs, such as by creating additional nodes to store business process records, renaming nodes,
and so on.

Every node, feature, and record can be accessed by way of the Navigator, which is always
available in the left pane of the screen. The Navigator is similar to a folder system, much like a
network drive. Each feature is stored in its own "functional node," similar to a folder, and some
nodes may be stored in "grouping nodes" that organize functional nodes based on their
properties. Each functional node is controlled by permissions. If you do not see a feature in the
Navigator, contact your project or shell Administrator or Company Administrator to verify that you
have been assigned the proper access permissions.

As you access different nodes on the left Navigator, the Navigator remains available on the left
of the screen, while the content frame on the right changes.
Unifier User Interface Screen Adjustments

The screen adjustments section of the interface contains the following elements, from left to
right:

» Collapse Sidebar
» Expand Navigation
» Collapse Navigation

Use the Expand Navigation or Collapse Navigation icons at the bottom of the Navigator pane to
expand or collapse all the nodes (modules) in the Navigator.
Unifier User Interface Log

This right pane displays all of the information pertaining to the nodes (or modules) that are
available for a company, shell, or project. The right pane houses the logs. Additional functions
are available from the options and links at various parts of the logs.
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On top, below the company, shell, and project tabs, the locator links (breadcrumbs) are
displayed. The locator links:

» Enable you to follow the path to the current location
» Always include home

Click the drop-down arrow of a locator link (breadcrumb) to reveal the direct children or
sub-shells of that location.

Even if you do not have permission to access a shell, the shell name appears in the breadcrumb
trail.

See the following topics for details on each static element, listed above.
The following topics display the dynamic elements of the Unifier user interface, and the
explanation for each dynamic element follows.

Note: The following screen captures are examples of a typical Unifier
dynamic user interface and might not be identical to the version that you
are using.
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Analytics Page

The Analytics Kl page that is available to users who have permission to access or view the
tab. The Analytics page displays analytic information to assist the user to make faster and more
informed business decisions by allowing the user to access dashboards that have been set up in
Oracle Business Intelligence Suite Enterprise Edition (OBI EE).
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Home Workspace

The Home workspace O is a tab that displays the user's (signed-in user's), tasks,
E-Signature tasks, notifications, emails from various workspaces, daily reports, and so on. In
addition, depending on the user's permission, the Home workspace displays the Master Log -
Business Processes grouping node. The Master Log - Business Processes grouping node
lists all of the business process types at the shell-level, or project-level, in separate functional
nodes for each type. This includes workflow, non-workflow, and multiple record business
processes.

Note: The Home workspace does not support the Admin mode.

The Home workspace contains the following elements:

» Left navigation, which contains the left Navigator that has several nodes (explained in the
table below).

» Log which visually represents information about the user's:
»  Number of tasks (Tasks)
» Notifications
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»  Mail

» Active Tasks (My Active Tasks)

» Task Distribution

» Workflow Business Processes
» Non-Workflow Business Processes

Typically, the Home workspace contains the following nodes:

Note: Your Navigator setup may differ, but the basic functionality will be

the same.
Node or Sub-node Description
Home Enables you to access the Home log which provides information
summaries for your:
» Tasks
» E-signatures
» Notifications
» Mail
» My Active Tasks
» Task Distribution
» Workflow Business Processes
» Non-Workflow Business Processes
You can click a tile to navigate to the respective log. For example,
click the E-signatures (in the Tasks tile) to go to the
E-Signatures log.
Within the left pane of the Home log, you can see pie chart (or a
circle chart) statistical graphic, which is divided into slices to
represent the number of active tasks by status and workspace
distribution.
Within the left pane of the Home log, you can see a list of tasks in
your workspaces, by business process type and status. You can
click a business process name to go to the BP log, within the
corresponding workspace (company or project).
Tasks Enables you to access the Tasks log and attend to the tasks that
have been assigned to you.
E-signatures Enables you to access the E-signature Requests log and attend
to any requests that you have received.
Notifications Enables you to access the Notifications log and attend to the
notifications that you have received.
Inbox Enables you to access the Inbox log and attend to all the emails
that you have received.
Drafts Enables you to access the Drafts log and continue your work with
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Node or Sub-node

Description

items in draft mode.

Sent Items

Enables you to access the Sent Items log and check for any
emails that you had sent.

Daily Reports

Enables you to access the Daily Reports log and attend to
reports that you have permission to access.

Contracts

Enables you to access the Contracts log and review the
contracts that you have permission to access.

The following provides more details for the Home workspace nodes:

Tasks

The Tasks log has the following toolbar options:

Toolbar Options

Description

Create

To create a new record. You need to
select a value for the following fields:

» Select Business Process Origin:
Your options are company or shell.
Depending on your selection, you can

click the Details icon ( & ) to open
the Select Business Process Origin
window, select a shell to list the names
of available BPs, make your selection,
and click Select.

» Select Business Process: You can
select a BP from the drop-down field.

You can create BPs records that involve a
workflow when working within the Tasks
module if you have permission to create
BP records. It is important to note that you
can only create Workflow BPs, and the list
of available Workflow BPs are according to
the shell or project that you are in.
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Actions

To perform one of the following on any of
your tasks, if applicable:

v v v vV v v Vv

Accept

Undo Accept

Action with Preview...
Action without Preview...
Hide

Unhide All

Print

Note: You cannot update the Bidders
email addresses in bulk (bulk update
through Bulk edit) or within multiple
records. You can only change a Bidder's
email address in a single record.

View

Your options are:

v v v v v v Vv

My Daily Reports

Received in last 7 days
Received in last 30 days
Group by Business Process
Group by Origin

Hidden Tasks

All Tasks

Create New View (See information at
the end of this topic)

Manage Views
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Edit View Enables you to open the Edit View window
and change the View Name. You can also
use the following tabs to change the
values of the:

Columns

» Available Columns

» Selected Columns

» Lock after selected Column

» Number of Records per Page
Filters

Based on:

» Record

» Advanced

Group By

To use the Add Column option, add
columns, and arrange the items.
Sort By

To use the Add Column option, add
columns, and arrange the items.
After you are finished, you can click:
Cancel to cancel your changes.
Apply to apply your changes.
Save to save your changes.

Save As to save your changes with a
different name.

4
4
4
4

Refresh Click this option to update the list of items
in your Tasks log.

Print To print your tasks (Print) or export your
tasks to a CSV or Excel file:

» Exportto CSV
» Export to Excel

Search To open the Search window (bottom of the
log) and search for a particular item.

Find on Page To find a task based on the column
headings. When you click this option, the
system inserts a row that lets you enter
filter parameters.

The Tasks log has the following columns:

» Project Number
» Origin
» Business Process
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Record Number
Title

Record Due
From

Sent for

Task Due
Received
Workflow Name

v v vV vV vV vV v Vv

Create New View

To create a new view for your log, click View drop-down and click Create New View to open the
New View window. By default, the Columns tab is selected.

1) From the Available Columns box, select the columns that you need and click the Move icon
(the single arrow icon pointing to the right) to move your selected column to the Selected
Columns box. The Selected Columns box contains the columns that are seen in the log
view. The last column in the Selected Columns box is not available for locking.

2) In case you want all of the available columns to be seen in the log view, click one column to
select it (in the Available Columns box), click the Move All icon (the double-arrow icon
pointing to the right) to move all columns to the Selected Columns box.

3) To move multiple available columns at a time, click one column to select it (in the Available
Columns box), and then hold down the Ctrl key and proceed to select each desired column
from the Available Columns box. Once finished, click the Move icon (the single arrow icon
pointing to the right) to move all of the highlighted columns to the Selected Columns box.

You can move each column in the Selected Columns box by using the:

» Move Up icon (the single up-arrow icon)

» Move Down icon (the single down-arrow icon)

You can move multiple columns in the Selected Columns box by using the:
» Move to Top icon (the double up-arrow icon)

» Move to Bottom icon (the double up-arrow icon)

To lock columns in the log view or determine the number of records, or both, use the
following drop-down fields in the New View window, respectively:

» Lock after selected Column
» Number of Records per Page

E-signatures

When a Send for E-Signature action is taken, and one or more documents are sent to users
(internal user, external user, or proxy user), an entry is made in the E-Signatures functional
node to enable the user to act on the E-Signatures task. For more information, see Working
with E-Signatures in the Unifier User Help. The E-signatures log has the following toolbar
options which enable you to work with each E-signature item:
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Toolbar Options Description

View To set the items in the log by selecting one
of the following options:

» All < default

» Group by Status
» Create New View
» Manage Views

Edit View To select which columns to be displayed or
remain hidden, apply filters, group and sort
by available fields and to save custom

views.

Delete To delete an item in the log.

Refresh To update the information displayed on the
screen.

Print To print the information displayed on the

screen. Your other options are:
» Export To CSV
» Export To Excel

Search To search for related items.

Find on Page To filter results displayed on the screen.
When you click this option, the system
inserts a row that lets you enter filter
parameters.

The E-signatures log has the following columns which provide details about each E-signature
item:

Name

Form

E-Signature Status

Subject

Location

Received Date

Completion Date

v v v vV v v Vv

When you click an item in the E-signature log, the right part of the log provides properties
information.

Notifications

When you receive a task, your task will appear in the Notifications log. The Notifications log
contains the following toolbar options which enables you to work with each notification:
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Toolbar Options Description

Actions To select one of the following actions for
your notification:

Print

» HTML

» PDF

» Custom
Delete

View To select one of the following options:
All Notifications < Default
Received in last 7 days
Received in last 30 days

Group by Business Process
Group by Origin

All Notifications

My very own view

Create New View

Manage Views

v vV vV vV vV VvV v v Vv

Edit View Enables you to select which columns to be
displayed or remain hidden, apply filters,
group and sort by available fields and to
save custom views.

Delete To delete an item in the log.

Refresh To update the information displayed on the
screen.

Print To print the information displayed on the

screen. Your other options are:
» Export To CSV
» Export To Excel

Search To search for related items.

Find on Page To filter results displayed on the screen.
When you click this option, the system
inserts a row that lets you enter filter
parameters.

The Notifications log contains the following columns which enables you to work with, and learn
more about, each notification:

» Attachments
» Business Process
> From
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> Title

» Record Number
» Origin

» Received

When you click a notification in the Notifications log, the right part of the log provides properties
information by way of the following tabs:

Record Details tab
This tab provides the details about the selected notification, within the fields in the following
blocks:
» General block
» Action Item Information block
» Meeting Details block
» Description block
Workflow Progress tab
This tab provides the following workflow details about the BP that was indicated in the
selected notification:
» Title
» Record Number
» Current Step
» BP Setup Used
» View Graphic (to view Workflow Progress - Graphic. You can print the graphic)
» Filter By
» Visited Steps
Attachments tab
This tab provides the following details about the attachments that were included in the BP
that was indicated in the selected notification:
» File Name
» Title
» Pub. no.
» Tab Name
» Size

For each item in the Attachments tab log, the gear icon menu items enable you to conduct
the following actions on the attached file:

» Open
» Open in AutoVue
» Download

Inbox

The Inbox is:
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» An internal email feature that allows shell team members to communicate with each other
and maintain a record of the communications. For shells with View-Only status, Mailbox is
available for viewing, but you cannot send, edit or delete messages.

» The repository that collects external emails related to the shell. These emails can come from
shell users or from external users who do not use Unifier. From the Mailbox, users can
forward the emails to appropriate members, flag them for review, and reply to them. In
addition, these external emails can be linked to business process records.

» A cross-shell listing of your Inbox can also be accessed in the Mailbox grouping node of
your shell. Refer to the Unifier Shells and Projects User Guide for details.

» A cross-project listing of your Inbox can also be accessed in the Mailbox grouping node of
your project. The Mailbox grouping node displays all of the internal and external emails in a
project.

Replies from external users can be tracked and monitored from within your Project Mailbox.
Refer to the Unifier Shells and Projects User Guide for details.

When you receive an email, your email will appear in the Inbox log.

To view all your email messages (Mailbox) across shells
1) Go to the Home workspace.

2) In the left Navigator, click Inbox. All messages sent between shell team members
(messages residing in all shell Mailbox Inbox and Sent folders) are listed.

3) To open a listed message, select it from the list, click the gear menu, and click Open.

When an email is selected from the Inbox log, the contents of the email are displayed on the
right along with the possible actions.

You can use the gear menu ( % ) to perform the following actions: Open, Flag (All available
options are displayed), Clear Flag, Print, and Delete for each record.

The following toolbar options are displayed on the Inbox log:

Toolbar Option Description

Actions This option enables you to take the
following actions:

» Flag: To flag one or more emails. All of
the following available sub-options are
displayed.

Call

Do not Forward

Follow up

For Your Information

Forward

No Response Necessary

Read

Reply

Reply to All

Vv vV vV vV vV VvV v v Vv
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Toolbar Option

Description

» Review

» Clear Flag: To clear the flags. This
option is context-sensitive.

» Print: To print the log.
» Delete: Delete one or more emails.

View

To customize the view according to the
following criteria:

» Received in last 7 days
Received in last 30 days
Group by Business Process
Group by Origin

All Items

Create New View...
Manage Views...

This sub-menu will also contain all views
that you have created.

»
»
»
4
4
4

Edit View Z

To edit the view (columns) of the Inbox
log.

Search Q

To open the Search window and enter
search parameters. You can search for
items that are not currently displayed in the

log.

Find on Page =

To find items on the displayed page. When
you click this option, the system inserts a
row that lets you enter filter parameters.

Refresh (C)

To refresh the log screen.

Expand All Groups
OR
Collapse All Groups

When you expand a group from the log
and select an item:

» The gear icon menu enables you to
Open, Flag, Clear Flag, Print, or Delete
the item.

» The Inbox log splits and the right of
the page becomes the reading pane
for the message.

Drafts

Click Drafts to see all the business processes that are in a preliminary version. You can
navigate to the Drafts functional node from the left navigator.
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The following columns and icons are displayed in the log:

Attachment icon (displays if the upper form of the drafts has any attachments)
Business Process (Name of the BP)

Record Number (Record number of the Dratft)

Title (Title of the draft)

Origin (The source name where the draft was created)

Last Saved (The date that the draft was last saved)

v v v v v Vv

From the Drafts log, you can use the gear menu ( ¥ ) to perform the following actions: Open,
Go to Origin, and Delete.

When a draft record is selected from the log, the Record Details, Workflow Progress, and
Attachments tabs are displayed on the right pane.

Toolbar Option Description

Actions The following option is displayed:
Delete: to delete drafts.

View To customize the view according to the
following criteria:

» Saved in last 7 days

» Saved in last 30 days
» Group by Business Process
» Group by Origin
» All Drafts

» Create New View...
» Manage Views...

This sub-menu will also contain all views
that you have created.

Edit View( 7 ) To edit the view of the log. You can edit
the view of the following elements on your
log:
» Columns
» Filters
» Group By
» Sort By

If you modify the view and do not save the
changes, the system keeps the existing
name and adds the word "Modify" to the
existing name. You can click Clear to clear
your selections.

Refresh (C) To refresh the log screen.

Print (8 Print) To print the contents of the log, export to

54



Getting Started with General Operations

Toolbar Option

Description

CSV, or export to Microsoft Excel.
Notes:

» For export to Microsoft Excel, the
system currently supports only Euro
(EUR) and United States Dollar (USD)
currency symbols.

» If you export data from a business
process (BP) record, sheet (such as an
Activity Sheet), or log (such as
Company Funding Sheet Log) to
Excel, be aware that depending on
how your negative values are
formatted, you might need to configure
your columns in Excel to match the
correct data type (Number). Otherwise,
the columns will not be treated as
numeric and will not sum as expected.
One supported format includes placing
the negative sign between the currency
symbol and the amount (for example,
$-1,000).

Search Q

To open the Search window and enter
search parameters. You can search for
drafts that are not currently displayed in
the log.

Find on Page =

To find items on the displayed page. When
you click this option, the system inserts a
row that lets you enter filter parameters.

When you click a draft in the Drafts log, the right part of the log provides properties information

by way of the following tabs:
» Record Details tab

This tab contains the details associated with the BP record, which can be edited when the

BP record is opened from the drafts log.

» Workflow Progress tab

This tab provides the following workflow details about the BP that was indicated in the

selected notification:
» Step Name
» Assignhee
»  Company
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» Status

» Action

» Completion Date
» Attachments tab

This tab provides details about the attachments that were included in the BP that was
indicated in the selected draft.

Sent Iltems

You can use the Sent Items functional node to open the Sent Items log and check for any
emails that you had sent.

The Sent Items log has toolbar options that are similar to the Inbox log.
The Sent Items log has columns that are similar to the Inbox log.

Each item in the log, when selected, has a gear icon. The gear icon menu enables you to Open,
Flag, Clear Flag, Print, or Delete the item.

When you click an item in the log, the Sent Items log splits and the right side of the page
becomes the reading pane for the message.
Company Workspace

The Company Workspace page is a tab that has two modes:
» The Admin mode i
» The User mode &
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The following image shows the typical Admin mode for the Company Workspace tab:
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The following image shows the typical User mode for the Company Workspace tab:

Shell or Project

The Shell page, or the Project page, has two modes:

» The User mode

» The Admin mode

A shell is a “container” in which users can organize entities, such as projects or facilities. This
shell is where users can organize business information in one place to make managing it easy.

A shell can include the functions and features necessary to manage the information in that shell,
such as a Schedule Manager, a Document Manager, and a Cost Manager.
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Standard “projects” work in a similar manner. The difference is that a shell is not required to
function like a time-based project. A shell can encompass a static entity, such as a university
campus, where maintenance activities are on-going. An example of such a shell could
encompass a college campus in order to track building maintenance and new additions. You
could include a Space Manager for improvements and remodeling, a Document Manager for all
the documents and drawings necessary for new additions, and a Generic Cost Manager for
costing functions.

Shells can be arranged in hierarchies to represent a company's physical or organizational
structure, such as:

» State

» City

» Property

» Building

Shell Dashboard

A dashboard that is accessible at the shell level and can be used to view data within a particular
shell hierarchy. There are several types of shell dashboard: My Dashboard or Shell Instance
Dashboard.

The following image shows the typical User mode for the Shell tab:
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The following image shows the typical Admin mode for the Shell tab:
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The following are for a shell-project:

To access the Preferences (user preferences) window:
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1) Inthe upper-right corner of your window, click your user name to open a contextual menu.
The menu offers a limited set of choices that are available in the current state. For example:
» Get Unifier Mobile App
» Preferences
» Change Password
» Proxy For
» Last login
»  Sign Out

2) Click Preferences to open the Preferences window. The Preferences window contains the
following tabs:

» General

» Security

» Email Subscription
» Region Format

» Proxy

» More

The following describes each tab.

General Tab
Use the General tab to view contact information for the company directory.

You can include the user's photo by clicking from the left side. The existing Image picker only
supports images of type jpg, jpeg, png, and tiff.

You can upload a profile picture by using the Upload Photo option.

Viewing your Company Contact Information

Use the General tab of the Preferences window to view your company contact information such
as the contact's Name, Title, Email, Work Phone number, Mobile Phone number, Pager number,
Fax number, and Address (City, State/Province, Zip/Postal Code, and Country/Region).

Note: The Company Administrator manages user profiles, including the
contact information. Contact your Company Administrator if you want to
update your information.

If the "Hide User Profile" option is selected (by the administrator) in the Company Properties
(Security tab), then you cannot view the basic information which includes field values such as
Email address, phone number, and so on. This applies to the basic information that is available
as a part of user profile.

Example

The Task Details section in a Workflow BP has To, From, CC fields. If the check box is
selected, the Basic Information block will be hidden.

Administrator name in Shell landing page and Company landing page.
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User Picker such as Creator in BP forms, shell forms, and so on.

Security Tab
Use the Security tab (of the Preferences window) to:

» Change password
» Manage password reset and recovery (on-premises only)
» Manage secret questions.

Notes:
= You cannot recover/reset your password if you do not set up
password recovery secret questions and corresponding answers.

= For better security, change your password at regular intervals. Your
Company Administrator may require you to change it at set times.

= When you change your password, you will automatically be logged
out. Log in again with your new password.

You can change your password in two ways:

» Using the Security tab of the Preferences window (for first-time users).
» Using the Change Password option (for returning users). See Change Password (on
page 79) for more information.
To change your password using the Security tab of the Preferences window follow these steps:

I. Go to the Security tab in the Preferences window.

2. Enter your current password and new password in the Current Password and Password
fields. To view the password policy, click the Password Help tooltip above the New
Password field.

3. Confirm your new password by entering the new password in the Confirm Password field.

Under Password Recovery Secret Questions section of the Security tab, select a
guestion and enter the answer. You can designate up to three secret questions.

5. Click Apply and click OK to close the Preferences window.
To change your password using the Security tab of the Change Password option follow these
steps:
I. In the upper-right corner of your window, click your User Name to open a contextual
menu.
Click Change Password to open the Change Password window.

3. Enter your current password and new password in the Current Password and Password
fields. To view the password policy set by the administrator, click the View Password
Policy link.

4. Confirm your new password by entering the new password in the Confirm Password field.

5. Click Save to complete changing your password.

You can recover your password from the Sign In Page.
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To recover your password:

2.
3.
4

Go to the Sign In page.

Click Forgot Password? link to open the Reset Password window.
Enter your user name and email in the User Name and Email fields.
Click Submit to show the Secret Question.

Note: If you did not set up the Password Recovery Secret Questions, or
if your account is Inactive or On-Hold, you will receive an error message
instructing you to contact Oracle Customer Support.

Enter the answer to your secret question field and click Submit. A system-generated
email containing a temporary password will be sent to you automatically.

Click OK in the Alert window.

Go to your email inbox and open the system-generated email titled "Unifier Password
Reset Notification" and follow the instructions.

Password/Login Policy

4

Minimum overall characters: Minimum number of characters that a password must
contain; default is one (1).

Maximum overall characters: Maximum number of characters that a password must
contain.

Minimum numeric characters: Password must contain a minimum amount of numbers.
Minimum alphabetic characters: Password must contain a minimum amount of letters.
Minimum special characters: Special characters are [{~!|@#$%&*()-_=+;:"",<.>/?}].

Password cannot be same as Username: Users cannot use their user name as a
password.

Password cannot be the same as the user's First or Last Name: Users cannot use their
first or last name as a password.

Password cannot be same as last password(s): A newly changed password must be
different from the previously used passwords.

Email Subscription Tab

The Email Subscription tab (Preferences window) enables you to set up email subscription
details. The Email Subscription tab contains the following blocks and fields:

»

v v v v v v Vv
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Send natifications in single daily digest

Workflow Business Processes
Non Workflow Business Processes
Portfolio Manager

Document Manager - Project/Shell
Document Manager - Company
Mailbox

User Defined Reports
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» Alerts
» Gates
» Project/Shell

The following provides details.

Selecting Email Subscription Options
Email Subscription

The email subscription option enables each user to control the number, type, and frequency of
Unifier-related email notifications received. Users can subscribe to, or opt-out of, receiving email
notifications for events.

Send notifications in single daily digest

Select this option if you want to receive your email notifications in a consolidated email, once
a day (single daily digest), instead of receiving the notification emails individually and per
event. Deselect this option to receive email notifications individually and per event.

Note: The maximum number of messages in a single daily digest
depends on the length of the messages. The system will send up to the
latest 100 messages in single daily digest. The older messages will be
removed and will not be included in the digest.

Before you begin selecting email subscription options
Permission

To receive an email notification for a module and/or event, you must have view permission for
that module and/or event. This view permission is set in Admin mode.

Note: If you do not have view permission, your email notifications
settings do not override the original permissions (set by your Company
Administrator), and you only get email notifications for modules and/or
events that you have permission to view.

Document Manager notifications

In addition to module-level view permission, you must also have at least view permission on the
specific documents or folders that would generate the event email. These permissions are set by
Company Administrator and from within the Document Manager. In addition, the owner of the
folder has the option of not generating email notifications for specific events.

External email accounts

If you are using an email address from a generic email account such as Yahoo, Hotmail, and so
forth, your spam filter may filter out these notifications. Refer to your email provider regarding
how to allow these notifications to reach your inbox.

To receive email notification for a module or event
1) Go to the More tab in the Preferences window.
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2) Select your choices from the scrolling window. For more information, see the following
tables.

To opt-out of receiving email notifications for a module or event, simply deselect the items from
the scrolling window.

To subscribe to or opt-out of email notifications
1) Go to the Email Subscription tab in the Preferences window.

2) From Email Subscription field, select the modules and events for which you want to receive
email notifications. If you do not select a module or event, you do not receive email
notifications related to the unselected module or event. For more information, see the
following tables.

The events apply to the following modules:
»  Workflow business processes

» Non-workflow business processes
» Document Manager - Project/Shell
» Portfolio Manager

» Document Manager - Company

»  Mailbox

» User Defined Reports

» Alerts

» Gates

» Project/Shell

» E-Signatures

3) To opt out of receiving email notifications regarding specific events, deselect the check box
for the notification.

4) To receive email notifications in one email summary per day, click the Send notification in
single daily digest check box. The summary email will be sent if one or more events trigger
an email notification.

5) When finished, click Apply and OK.

Notes:

= For permission-based emails, email notification is usually sent the first
time permission has been granted and not when permissions are
modified, unless otherwise noted.

= Document Manager email notifications are only sent if users have at
least view permission on the affected item, and if the item owner
enables email notification.

Modules and Events Options
This section describes the events within each module.
Workflow Business Processes
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permission for the business process (BP). You can opt to receive email notification. See the
following table for details.

For

When

Personal tasks

You are part of the assignees list when a BP is sent (this becomes a
task for you).

Decline tasks

A task is declined by one or more of the assignees that you have
added to a BP that you sent.

Overdue
personal tasks

An assigned task is past the due date.

Messages Someone cc's you on a BP.

Record The record Workflow is complete and the Workflow end step has

Workflow been reached; this is applicable on any Workflow BP where user is

Complete selected as part of the "Notify users on workflow completion” setup
under the BP Setup > Setting tab.

Record A certain step occurs in a workflow (if your Administrator has enabled

Modification workflow actions for the workflow step) that needs action. Actions are

shown as hyperlinks in the email.

Non-Workflow Business Processes

These events pertain to non-workflow business processes. To receive notification, you must

have at least view permission for the business process (BP). You can opt to receive emalil

notification. See the following table for details.

For

When

Record Creation

A new record is created.

Record
Modification

A record or line item is modified, a line item is added or deleted,
comments or attachments are added, attachments are removed.

Portfolio Manager
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For When

Scenario When the user has defined the list of users, or groups, in the Portfolio

Shared or Manager configuration, then when the scenario sheet is approved or

Approved shared, the respective list of users, or groups, will receive the
notification.

If the list of users, or groups, is defined in the Portfolio Manager
configuration, but the option in user preferences is not selected, then
the user will not receive any notification.

This option is not selected by default.

The option will also be seen in the "User Preference Template," in the
Preferences tab. When the "update users" action is performed, the
value is pushed to the user preferences.

The subject of email notification that is received by user states if a
Project Portfolio scenario sheet is approved, or approved and shared.

Note: Only an active user receives the notifications.

Document Manager - Project/Shell and Document Manager - Company

Note: With this module in particular, a user modifying multiple
documents or folders, or folders with many subfolders, can potentially
trigger a large amount of email. You can prevent receiving too many
notifications by choosing the digest notification (one email) option, or
limit the events for which you want to receive notification.

Users with view permission (set in the Document Manager) on the applicable document, folder,
or shortcut target receive notification when the following occurs:

For When

Document A new document is uploaded into the folder.

upload

Transfer File or folder ownership is transferred. The new owner is notified.

ownership

Move A document, folder, or shortcut is moved from one location or folder
to another.

Delete A document, folder, or shortcut is deleted.

Document A document is revised.

revise

Folder rename | A folder is renamed.

Mailbox
For When
Personal Mail Users receive an email notification when new mail is received.
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User Defined Reports (UDRS)

For UDRs, the users receive email notification under following conditions:

For When
New report The user is granted at least run permission to a user-defined report
granted by another user.

Results from
scheduled
reports

When a scheduled report has been generated and the results are
available; requires run permission be granted for the report.

Alerts

For alert, the users receive email notification under following conditions:

For When

Each alert Users can receive notification when an alert is generated.
Gates

For When

Change Phase |User receives notification when a phase is changed.
Notification

Auto-email PDF |User receives a PDF copy of an automated gates run.
Gates run

Project/Shell

For When
Successful The Program Manager, Project Manager, or Project Administrator
Creation receives notification of the successful creation of a Project/Shell. This

notification occurs if the Project/Shell is created manually, through
Web Services, using a CSV file, or through auto-creation.

E-Signatures

For When
E-Signature An internal signee receives email notification for the E-Signature
Requests request created in the E-Signatures functional node. When you

select the E-signature Requests option in the User Preferences, then
the system sends an email to the user when an E-Signature request
is created for that user in the E-Signatures functional node at
company, project, or shell.
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When you select Send notifications in single daily digest, and there are notifications relating
to the E-Signature Requests, then the single digest email to the recipient will contain the
E-Signature message along with other messages in the email. The header section (where
hyperlinks to each message within the digest are mentioned) contains the hyperlink to the
E-Signature message with the text: <Document Name> is sent to you for review and sign.

Note: You do not have the option to send the document as an
attachment in the email notification.

You can send the documents in the Document Manager, and the documents attached to a
business process record for review and signature to one or more Unifier and non-Unifier users.

Region Format Tab
Use the Region Format tab to manage settings such as:

» Language, date and time format
» Preferred Region
» Language
» Time Zone
» Date Format
» Number and Currency Formats
» Decimal
» Digit Grouping Symbol
» Digit Grouping
»  Show Currency Symbol
» Positive Currency Format
» Negative Currency Format
» Negative Number Format

This tab also provides a Currency Example.

Changing Time Zone and Date Format
The following settings are maintained in the Region Format tab of your Preferences.

The Time Zone setting affects the date stamp that appears on the actions that you perform,
such as saving or uploading files, running user-defined reports, and due dates of tasks assigned
to you. The date stamp is effective as of 12:00 AM in your time zone.

Example

If your time zone is Eastern Standard Time, and your task is due August 1, then at 12:00 AM
August 1 your task is due — even if it is only 9:00 PM July 31 in Pacific Standard Time.

Note: The Time Zone setting is based on the Coordinated Universal
Time (UTC).

To set the time zone:
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1) Goto the Region Format tab in the Preferences window.
2) Click the Time Zone drop-down list and select a time zone based on your locale.
3) When finished, click Apply and then OK.

The Date Format determines how date fields appear.
To set the date format:

1) Goto the Region Format tab in the Preferences window.
2) Click the Date Format drop-down list and select a date format.
3) When finished, click Apply and then OK.

The system supports the following additional date formats:

Notes:

= The time format for all dates is: HH:MM. The Date Format options is
displayed without AM to support the 24-hour format. For example, in
the Date Format drop-down, instead of MM/DD/YYYY HH:MM AM,
MM/DD/YYYY HH:MM is displayed to enable you to select the
24-hour time format.

= The system provides you the option to select 24-hour date time
format in all modules, once this is set in the user preferences
(Preferences). This is supported for all Standard, Portal, Partner
users, and bidders.

MM/DD/YYYY
DD/MM/YYYY
MM/DD/YY
DD/MM/YY
MM-DD-YYYY
DD-MM-YYYY
MM-DD-YY
DD-MM-YY
DD.MM.YYYY
YYYY-MM-DD
MMM/DD/YYYY
DD/MMM/YYYY
YYYY/MMM/DD
M/D/YYYY
M/DIYY
D/MIYYYY
DIMIYY

YY/M/ID
YYYY/M/D
YY/MM/DD
YYYY/MM/DD

VvV VvV ¥V ¥V VvV VvV VvV ¥V VvV VvV vV VvV VvV VvV vV vV VvV VvV v v v
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Changing Number and Currency Formats
The following settings are maintained in the Region Format tab of your Preferences window.

The Number and Currency Formats section of the Region Format tab of your Preferences
allows you to:

» Select Preferred Region from a list. This is the region that you want.
» Set the Decimal Symbol for your currency from a list.

» Set Digit Grouping from a list.

» Set Show Currency Symbol to show or not.

Note: If the administrator does not select the Show Currency Symbol
option, the system ignores the options that are selected for Positive
Currency Format and Negative Currency Format, and does not
display symbols. The following applies to all objects (such as Form,
Sheet, Cash Flow, Dashboard, and Log) that use the Currency Data
Element.

Set Digit Grouping Symbol from a list.
Set Positive Currency Format from a list.
Set Negative Currency Format from a list.
Set Negative Number Format from a list.

When finished, click Apply and then OK.

The Number and Currency Formats section of the Region Format tab also provides examples
for the following:

»
»
»
4

» Currency
» Decimal Number
» Integer Number

The examples show the arrangement of the numbers (the way the numbers are displayed) in the
forms when a particular formatting option has been selected.

For decimal numeric data, the precision is governed by the "Decimal Places" set in the Data
Element properties.

Note: When the Company Administrator creates a User and selects a
language, the values of the number formats are populated accordingly
and displayed in the Region Format tab of the Preferences window.
The number formatting options are not displayed in the User Properties
window. The number formatting options are displayed in the
Preferences window. If the Company Administrator changes the
language value in the User Properties window, the Region Format tab
of the Preferences window shows the same languages as in User
Properties window and the number formatting options remain the same.

Changing Language
The following settings are maintained in the Region Format tab of your Preferences window.
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To set the language:

1) Gotothe Region Format tab in the Preferences window.
2) Click the Language drop-down list and select your language.
3) When finished, click Apply and then OK.

Note: The languages listed are the active languages selected by the
administrator in the Configuration - Internationalization log.

The following languages are supported:

Arabic

Chinese (Simplified)
Chinese (Traditional)
Dutch

English

French

German

Italian

Japanese

Korean

Portuguese (Brazil)
Russian

Spanish

Vv vV vV vV vV VvV VvV VvV vV vV v v Vv

Note: The rendering of Unifier content in Arabic language in third party
applications (such as Email Client, Adobe for PDF, and so forth) is
outside of the application purview.

Numeric Format Based on Language Selection

The Numeric formats such as the decimal symbol, grouping, and so forth are based on the
language selected for the bidder.

For the Vendors records that are created through CSV or Web Services, the user can specify
the values for the Language, Time Zone, and Date Format Data Elements and create Vendors
records in Bulk. The existing codes for these fields can be used to specify the values. The list
below is derived from the Java API.

Decim . L . :

. I . Digit Positive |Negative |[Negative
LGgua E(??rlnoz; gl mb [S)|gn|1tb((3)|roup|ng Groupi |Currency |Currency |Number
9 oly y ng Format Format Format
Simplifi | Chinese 123 45
ed (Simplified, | (perio |, (comma) 6 78’9 #123 #-123 -123
Chines |PRC) d) '
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e
Traditio Chinese
nal_ (Traditional | (perio |, (comma) 123,45 #123 -#123 -123
Chines . 6,789
e , Taiwan) |d)
Dutch - . 123,45
Dutch |(Netherlan |(com |. (period) 6.789 #123 #-123 -123
ds) ma) '
_|English 1. 123,45
English | (United (perio |, (comma) 6.789 #123 (#123) -123
States) d) ’
Space
French ’ represented by |123,45 i )
French | rance) gg)m blankinthe  |6,780 |125# |123# -123
product
Germa | German ' : 123,45 i )

N (Germany) Sgg)m . (period) 6.789 123 # 123 # 123
, Italian ' : 123,45 i )
Italian (Italy) Sgg)m . (period) 6.789 # 123 #123 123

Japane | Japanese . 123,45 i )

e (Japan) ép))erlo , (comma) 6.789 #123 #123 123

Korean . 123,45 i )

Korean (Korea) gc))erlo , (comma) 6.789 #123 #123 123

Portug |Portugues |’ . 123,45 i )

uese |e (Brazil) Eﬁg;n . (period) 6.789 #123 #123 123
Space

Russia |Russian ’ represented by | 123,45 i )

n (Russia) grc]:g)m blank in the 6,789 1234 123# 123
product

Spanis | Spanish ' . 123,45 i )

h (Spain) Eﬁg;n . (period) 6.789 123 # 123 # 123

Proxy Tab

Use the Proxy tab to:
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» Prevent assigning proxies (Do not allow Proxies)

Note: The Do not allow Proxies option is only available for the
Company Administrator (and in Admin mode).

Add multiple proxies (My Proxy tab: Users who can act as my Proxy)

See the list of users who can act as your proxy (My Proxy tab: Users who can act as my
Proxy)

» See the list of users who you act as their proxy (I am Proxy tab: Users | can act as their
Proxy)

» See the history of proxy login (Proxy Login History tab)
You can select/designate more than one proxy user.

You can be a proxy for multiple people, and you can designate more than one user as your
proxy.
Proxy users can be granted permission to access another user's account to complete tasks and

perform other functions on that person's behalf. When another person signs in as your proxy
user, that person will have access to all of the records and functions that you do.

When you designate another user as your proxy, the user will have access to all of:

» The records that you have generated
» The functions that you perform

When you designate another user as your proxy, the user will not be able to change your
Preference settings and the Audit logs reflect the actions taken by a proxy user as "on behalf of"
the original user.

You can limit the period in which the proxy user will have access to your account by specifying a
start and end date or leave their access active indefinitely.

Proxy users who are active (Status: Active) receive email notification of tasks to perform as
proxy. This applies during the time specified time period, using the Start Date/Time and End
Date/Time.

Note: If the proxy user must receive task notifications immediately, ask
the proxy user to ensure that the Send notifications in a single daily
digest check box is not selected. See Selecting Email Subscription
Options (on page 65) on the Preferences window, More tab.

Do not allow Proxies

Only Site/Company Administrators, Company users, and Partner users are permitted to select
the Do not allow Proxies option.

Note: This option is read-only in the user's Preferences window.
Users are able to add proxy users in their Preferences window only if the Site/Company

Administrator has not checked the Do not allow Proxies option in the Proxy tab of Edit User
window.
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The Proxy tab contains the following tabs:

» My Proxy tab

This tab enables you to determine the users who can act as your proxy (Users who can act
as my Proxy). This tab of the Proxy tab lists the users who can act as your proxy and allows
you to add, adjust the settings, remove proxies, and view the proxy login history.

If enabled by the Administrator, Partner Users can add Owner Company Users as proxy
users.

If you have access to more than one Company and want to assign a proxy for yourself in
those companies, you need to go into each Company and set the proxy user (Company >
your user name > Preferences > Proxy).

The topics that follow describe available user preference configuration settings for each tab,
in details.

» |am Proxy tab

This tab enables you to determine who you can be a proxy for (Users | can act as their
Proxy).

» Proxy Login History tab

This tab enables you to see a history of all proxy logins.
Choosing a Proxy User
Add (plus "+" icon)

If the Do not allow Proxies option is selected by your Company Administrators, then this option
is not available for you to use.

If the Do not allow Proxies option is not selected by your Company Administrators, then you
can use this option to grant proxy access to other users. To add a proxy, click Add and follow
the prompts.

Note: Your Company Administrator can assign other users to act as
proxies to your account if you are unable to do so.
Settings

If the Do not allow Proxies option is selected by your Company Administrators, then this option
is not available for you to use.

If the Do not allow Proxies option is not selected by your Company Administrators, then you
can use this option to select an existing proxy and change the user settings of your proxy, such
as start and end date/time. To change the user settings of your proxy, click Settings and follow
the prompts.

The system sets the values in the time-related fields base on the user's preferred data and time
formats.

If you do not specify a start or end date, the proxy user can access your account immediately
and their access privileges will not expire.

You can select Active to activate your proxy's access. To disable your proxy's access, select
Inactive.

Remove
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You can use this option to remove a selected proxy. To remove a user as your proxy, select the
proxy from the list and click Remove.

Proxy Login History
Use this option to view the following information about your proxies:

» Name

» Company

» Login Date
» Logout Date

The last login information appears on top.

Users | can act as their Proxy

If the Company Administrator has designated you as a proxy for another user, your user name is
listed under Users | can act as their Proxy field.

Note: As a proxy of a user, you have all the permissions that have been
granted to that user except that you cannot change the user's original
Preference settings even if the user has Administration permissions.

More Tab
Use the More tab to manage company settings such as:

» Viewer Options
» Default Viewer

» Viewer Exceptions
» Always use Native
» Always use Unifier

Choosing a Viewer Option
The following setting is maintained in the More tab of the Preferences window.

Note: Before you choose a file viewer option, you must have an active
AutoVue license and AutoVue installed and configured on your server.

The file viewer option determines how the system displays files (such as documents or
drawings) that are attached to business processes or stored in the Document Manager and
opened from within the system.

You can choose a default viewer, which will be used to open most file types. You can also
specify exceptions to this; for example, you may choose Unifier Viewer as the default viewer,
which will be used to open most file types, but then choose to open a few file types such as
drawing files and image files using the native software applications that reside on the user's
desktop machine.

To select a file viewer option:
1) Go to the More tab in the Preferences window.
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2) Click the Default Viewer drop-down list and select one of the following viewer options:
» Native
» Unifier Viewer

3) When finished, click Apply and then OK.

The following describes each of the default file viewer options in details:

Native

To open documents in their native software applications (for example, Microsoft® Word
documents are opened in Microsoft Word). In order to be able to use this option to view files,
you must have the native software application installed on your computer.

Note: The native software application does not display the document
graphical markups, but Unifier displays the document graphical markups
automatically, using the Unifier Viewer.

Unifier Viewer

To open documents in system-provided Viewer which will convert most file types to an image
format.

Note: If you select Unifier Viewer, the document opens in read-only
view, but it supports adding graphical markups and text comments (for
example, in attachments to business process and other records, or in
files in the Document Manager).

Setting Viewer Exceptions

The Viewer Exceptions section of the More tab allows you to specify exceptions to the default
viewer of your choice.
Example

If you selected “Unifier Viewer” as your file viewer and want “Native” to show a particular
extension and not the “Unifier Viewer,” enter the extension in the “Always Use Native:” field.

If you selected “Native” as your file viewer and want “Unifier” to show a particular extension
and not your Native software, enter the extension in the “Always Use Unifier:” field.
Notes:

= Omit the period before the extension.

= Separate multiple extensions by a semicolon, with no space in
between.
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Change Password

Changing Your Password as an On-Premises Customer

In the upper-right corner of your window, click your user name to open a contextual menu. Click
Change Password to open the Change Password window. In the Change Password window
you can:

» Change your password.
» View password policy.

Note: When you change your password, you will automatically be
logged out. Log in again with your new password.

Changing Your Password as a Cloud Customer
To change a password in your identity domain:

1) Inthe Primavera Portal, click Identity Cloud Service.
2) Log into the identity domain with your user name and password.
3) Click Change My Password.

4) Provide input for the required fields and click Submit when finished. Ensure that the new
password complies with the password policy.

Note: Wait five minutes before logging into an account after you have
changed your password.

Proxy For

To log in as someone else's proxy user:

1) In the upper-right corner of your window, click your User Name to open a contextual menu.
2) Click the Proxy For link to see a list of the users who designated you as their proxy.
3) Select the user name.

4) Select the user account to which you want to log in as a proxy and you will be immediately
acting on behalf of the user.

To log out as a proxy user:

Click the Sign Out link at the bottom of the User Name contextual menu. Your Proxy session
will end, but you will still be signed in to the system under your own user name.

Sign Out

In the upper-right corner of your window, click your user name to open a contextual menu. Click
Sign Out. For additional details, see Sign In, Sign Out, and Session Timeout (on page 27).
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Bookmarks

The function of bookmarks in Unifier is similar to the bookmarks that you create in a web
browser to help you access a web page more quickly, or navigate to frequently used locations.

Note: The system does not validate bookmark names, so ensure that
you do not add duplicate or confusing bookmark names.

You can add bookmarks to User mode functions where you frequently work.
Note: You cannot add bookmarks when you are in the Admin mode.

To add bookmarks:
1) Go to the tab/node that you want to bookmark.

2) Inthe upper-right corner, click the Bookmark icon (E) to open the Bookmarks window.
3) Click Bookmark this Page.

In the Bookmarks window, use the following options to remove, rename, or mark a particular
tab as a default tab:

» Remove

» Rename

» Mark as Default (to designate a bookmark as the default module shown to you at sign in)

Note: Accessing a tab/node through a bookmark is based on your user
permissions.

To use bookmarks, in the upper-right corner, click the Bookmark icon (E) to open the
Bookmarks window.

Master Log-Business Processes

Note: The name of this node can be customized.

Click the Master Log - Business Processes grouping node in the Navigator (left pane) to see
all of the business processes that you are involved in and you have permission to access. The
business processes log displayed (for each of the business processes under the Master Log -
Business Processes grouping node) is driven by the log design of the respective business
process. The log for a non-workflow BP includes an Edit Record column that indicates whether
the record is in an editable state by displaying an Edit Record status icon e. If the record has a
status such as submitted, terminal, or initiated, no icon is displayed.
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Note: If you do not have permissions to view any of the business
process types listed under the Master Log - Business Processes
grouping node (master log), then you will not see the Master Log -
Business Processes grouping node in the Home (Home workspace)

page.
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Company Landing Page (User)

When you (a user or an administrator) sign in, the system is in the User mode, by default. You
can switch between modes using the mode icon ({ai User mode and # Admin mode).

Note: The Home workspace O does not support the Admin mode.

To access company user functions, go to the Company Workspace tab and select User mode.
This displays the company landing page.

To access your company landing page (User):

1) Gotothe Company Workspace tab and switch to User mode.
2) In the left Navigator, click your company name.
The company landing page opens.

The company landing page has the following tabs:

» General
» Summary

You can add multiple tabs to the company landing page. To add a new tab:

1) Click the pencil icon (under the mode icon) to open the Company Dashboard window. The
Company Dashboard window lists the existing tabs and enables you to add, modify (edit),
or delete tabs.

2) Click the Create Tab option (the plus "+" icon) to open the New Tab window.
3) Enter a name in the Tab Name field, and click Save.

The newly created tab will be listed under the existing tabs on the Company Dashboard
window.

You can add multiple blocks (custom or standard) to each tab of the company landing page: To
add new blocks to a tab:
1) Select the tab.

2) Click the plus "+" icon (on the right side of the screen) drop-down arrow and select one of the
following types of blocks:

a. Custom

b. Standard

To add custom blocks on a tab:

I. Select atab.

2. Click Custom to open the New Custom Block window.

3. Enter the values (Source Details, Block Title, Block Length, and so on) in the fields and
click Save. The new block is added to the right pane.

To add standard blocks on a tab:
. Select atab. You can add both custom and standard blocks to a tab.
2. Click Standard to open the New Standard Block window.
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3.

Enter the values (Source Details, Report On, Block Title, Block Length, and so on) in the
fields and click Save.

The Data Type drop-down field (under the Source Details block) enables you to include
workspace type information (such as Active Workspaces, On-Hold Workspaces, and so
on) on the company landing page. Click the Data Type drop-down field, select
Workspace Information, and click Save.

To delete or edit a block use the trash-can or pencil icons.

You can:

»

4

Edit a tab name by selecting the tab and using the Edit Tab icon (the pencil icon) on the
Company Dashboard window.

Delete a tab by selecting the tab and using the Delete icon (the trash-can icon) on the
Company Dashboard window. You cannot delete the General tab or Summary tab
because they are system-generated tabs.

Reorder the tabs that are displayed on the Company Dashboard window by way of
drag-and-drop.

Select which tabs to be displayed on the Company Dashboard window by selecting the tab
(the select box). You cannot deselect the General tab.

Print a tab or maximize a tab by using the print icon or the maximize icon, respectively.

The General tab is divided into two sections:

» The left section displays the following information:

Company name and image (if it exists in the Company Properties page).
Description

Administrator

Homepage url

Locations

Other locations, if available, appear as grouping nodes in expanded mode below the first
address, and the map picker displays the pin markers for all other locations.

» The right section displays the following information in multiple blocks:

4

4

4

Tasks
Notifications
Company Workspace records: Workflow Business Processes

The Workflow BPs are all the workflow records for the user who has signed in. If the user
who has signed in does not have access to any of the Workflow BPs, at the Company
Workspace level, then the panes display a pertinent message. You can click the BP
name to navigate to the respective BP log.

Company Workspace records: Non-Workflow Business Processes

The Non-Workflow BPs are all the non-workflow records for the user who has signed in. If
the user who has signed in does not have access to any of the Non-Workflow BPs, at
the Company Workspace level, then the panes display a pertinent message. You can
click the BP name to navigate to the respective BP log.

The Summary tab contains summary information displayed within custom or summary blocks.
Similar to the General tab, you can add, edit, or delete custom and standard blocks.
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Shell Landing Page (User) - Details

To access your shell landing page (User):

1) Click your shell tab to open it.
2) Switch to User mode.
3) Click My Dashboard and click Details to open the shell Details form.

For more information about the shell landing page, refer to the Unifier Shells and Projects User
Guide.

The shell Details form enables you to access the following tabs:
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Tab

Description

General

This tab has the following blocks:
» General

» Description

» Location

This tab enables you to see and set the
following general information about the
shell:

Number
Administrator
Location
Description
Status
Latitude
Longitude

The fields in the General tab can be
customized. You can format the columns
when your Display Type is set as Table or
Grid. This enables you to re-size, for
example the Dashboard View Mode for the
Drill-downs, and Standard, or Custom,
blocks that the selected Display Type is
set as Table or Grid. This is similar to the
same feature available for the Business
Processes log. The system saves your
customized display automatically until it is
changed by another user.

You can also reorder the fields under the
Detail Form Tab Name. Use the Edit
Details Block option (New Standard Block
window) to select fields columns (Selected
Fields) by dragging and dropping the fields
from the Available Fields. You can also
use the deflector and collector options.

This action makes the order in which the
fields are displayed in the Details block of
Dashboard match the order defined in the
Selected Fields column in the New
Standard Block window.

vV v vV vV v v Vv

Currency

In this tab, you can:

» See the currency that the shell uses.
» Add new currency.

» Modify an existing currency.
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Tab

Description

Images

This tab contains the following toolbars:
Image (the plus "+" symbol) drop-down

menu:

» Browse: To upload images directly

from the local computer. You can
select and add multiple images. If you
select multiple images, the images will
be displayed in the shell dashboard, on

the image block, as rolling images.

» Document Manager: To see the
image files and folders that are
available in a shell Document
Manager. You must have the "View"
permission to see the images and
folders. Use this option to upload
images from the local Document
Manager (DM) of the particular project.
If an image is revised in DM, the
revised image is displayed in the shell
dashboard, on the image block. You
will be able to view images, from DM,
in the Dashboard in Admin as well as
User modes.

In the dashboards, if there are multiple
images, the system displays all of the
images as rolling images.

When a shell has multiple images, the
system uses the first image from the
list to print the shell image through
custom prints and reports.

Help ( ®): To display information about

this tab.

The tab also contains a log that lists the
names of the images that you have
downloaded. You can use drag-and-drop
to reorder the images on the log. Use the
trash-can icon to delete an image.
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Tab

Description

Options

Enables you to see, add, and set options

about the shell such as:

» Phase

» Time Zone for Background Jobs: This
time zone will be used to calculate the
time for running the recurring jobs,
specific to this workspace. If left blank,
the time zone that was set in the
Background Jobs (at Company-level)
will be used to run the jobs.

Financial Period

Email Address

Send Notification To

Document Manager Attribute Form

Document Manager Attribute Form
Used

» E-Signature Type

v v v v Vv

Links

Enables you to add new links and see the
existing links in the shell under the
following blocks on the window:

» New Links

» All Links

Calendar

Enables you to select one of the following
calendar types:

» Standard Calendar

» Custom Calendar (you can copy an
existing custom calendar)

Select Working and Non Working days by
choosing a day and selecting "Working" or
"Non Working" below. If you would like to
select a specific day of the week to adjust
the working status, click the day of the
week and select "Working" or "Non
Working" below.
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Tab Description

Custom Print Template Enables you to Add Selective Custom Print
Templates for shell specific business
processes.

After you select the Add Selective Custom
Print Templates check box, you can click
Add Templates to choose which business
process to apply templates to by moving
them from the Available Items list to the
Selected Items list.

Gateway Integration This tab enables you to link multiple P6
Projects with the following information:

» Project ID
» Project Name
» Schedule Type

Primavera Cloud Integration This tab lets you a single project to a
single Oracle Primavera Cloud project or a
single project (in multiple shells) to multiple
Oracle Primavera Cloud projects with the
following information (for more information,
refer to the Unifier General Administration
Guide):

» Project ID

» Project Name

» Primavera Cloud Workspace 1D

4

Integration Type

Opening records from drill-down Tables and Grid

When in a drill-down, the selected Display Type is Table, or Grid, and the Record Number is
selected in the Source Group By, the Record No. turns to a hyperlink. You can click the Record
No. to open the record in a pop-up window.

Note: The linked record will only be displayed if you have View or Modify
access for the BP record.

The Record Number will not be a hyperlink for the following:

» When source of the selected Data Cube (in Drill-down block) is Data View.

» In the Drill-down block, when the data is only selected from the Current Shell and sub-shells
or from sub-shells.

» If the selected Data cube has multiple BPs added as the Data Source.
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Common Procedures

This section summarizes some procedures that are the same or very similar in different sections
and modules within the system.

In This Section
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Queries

You will be using queries to extract data from the database for reports and data pickers, and to
set up auto-creation with creator elements.

A query is a data mining tool—a method for retrieving information from a database. A query
filters the information returned from the database according to restrictions or conditions you
specify. Unifier queries can:

» Filter or narrow the data being retrieved for use in reports and manager sheets

» Set up conditions or triggers to make something happen automatically

» Filter or narrow the data being retrieved for use in a data picker element

In This Section

Using Formulas or Conditions in QUETIES..........ccuiiiiiiiiiiiiiiiiiieeeeee e 95
HOW QUENES WOTK ..ottt et e e e et e e e e e e e e e et e eeees 98
Assignee Filter Query COoNItioN ............uiiiiiiiiiiiee e e 99
Query Based Data Element (QBDE)........coouuuuiiiiiieiieeeee e 100

Using Formulas or Conditions in Queries

For queries, you can evaluate the data before retrieving it from the database to determine
whether to include the value in the report, manager sheet, or data picker, or to spawn an
auto-creation. To evaluate the data, you can use a formula or a condition.

In formulas, multiple fields can be calculated to arrive at a certain value that the data must meet
before it will be used. The value can be one that you enter, or a value from another field.

You can include formulas in conditions.
In the Condition field, select the condition the value in the field must meet.

The following explains the formulas that you can use in a query.
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Field Value Comparison

The formula for field value comparison produces data that meets a field value (string or numeric)
from the form of a business process or a shell in a hierarchy, or a constant. This is then used to
populate a data picker.

Add Query Condition
Diata Elerment ContactLastMame — Test the value of thiz field...
S . - ...u=ing thiz operator...
Conaion foontaine T T
Values i
@ Dynamic 1. ..against the value of thiz field

in thiz data source (buginess
process or ghell)
OR
1 _.againgt thiz word(z)
or number(s}

Diata Source: i_—sa{l_g:::l-

Data Element | -Seladh-

O Congtant

ok | cance |

Date Plus or Minus
The formula for date adds or subtracts a value to or from a date.

Date Difference

The formula for date difference subtracts one date from another to give you the number of days
between the dates.

Dabe Diiference
Eariier Diabe: (¥} Last Uipdate Date of Planning Shesl \L. .
i f | Thiz date...
i 1 j,-f'"'

Later Diate : LBSHWchDBlﬂ_ﬂFIBﬂ_Mﬂ_ShB_ﬁ‘I -\‘\'L- weill be subtracted from
( O] i P this date to produce the
| Cadulation based on: (3 Calendar days O Work days date ditference.
§ {2} 5how Partial Days.

The date diffierance (in days) is calculabed as (Later Diabe) - (Ealier Dale),

ok | cancel |
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Compare Date Fields

You can also compare date fields as part of a query.

D4t Erermant Creaben Dite v e Test the value of this datas element ...
Sondilei prrvr B e Lusing this operator ...
[ater .against the value in this elemert ...
Data Element (5 -Seie v *""f oOR
Bate: = g - AGAINEt the date you enter here..,
OR
Todiy d . against today's date
ASVSract daye Phss v . [optionally) plus or minus...
Nurnber of days Ahe value inthis element,,
Data Elemaent (3 -Select - .n-d"'"".‘f R
o — - AhiE number of days.

Dynamic Date Value

You can compare a date field value with a date field from the form of a business process or a
shell in a hierarchy, a specific date, or today's date, and also add or subtract days to the result.
This is then used to populate a data picker.

Agd Quesry Condition

Diata Element Diale w #—— | Tezt the value of thiz data element.
P P o a—— | LEiNg thiz operator...
Drater
& Dynamic ...againzt the value of thiz field
in thiz data zource (bugineszs
Diata Source: -Seledt w
procesz or zhell)
Data Element | -Seled- w o5
r Dale =z +——— | ...again=t the date yvou enter here...
i 'r d ] OR
L Tedwy < ...againzt today's date
AddrSubiract days Phiss « +—— | [(optionalky} plus or minus...
Humber of days
(= Cynamic
Data Source Beled ) ...the value of thiz field in
Diata Element Sededt - . this data source...
= OR
r Days +———— | __thiz number ofdays.

oK Cancel
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Between Dates

You can compare a date field value to see if it falls between two dates. This is then used to
populate a data picker.

Add Cuery Condition
Data Elerment Date v ——— | Test the value of thiz date
Condition rr— o o— | tozecifitiz between. ..

Date
@ Dynamic ...the date in thiz field in thiz

Dala Sowrce: | -Seled i’ / data =ource (businezs
process or shell)
Data Element | -Seled- * OR

- 4——| ..the date you enter here...

) Date
o OR

O Today < .today's date. .
e AND
Data
(& Dynamic

Diata Source: | -Seladh % ...the date in thiz field in thiz

data =ource

Data Element | -Seled- w oR
O Date T—— ..the dﬂt&guﬁu enter here...
O Today - . today's date.

O Cancel

How Queries Work
The way queries work in Unifier is as follows:

» You mine down to the information you want by choosing an element (field) in the database
on which to base the query.
» You test the data against conditions and values that you specify.

A condition is a state or restriction that the value in the data element (field) must meet. A
condition of the value might be that it must be equal to a certain number (for example, 10) or
that it must contain a certain string of letters (such as "due date of").
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» When (or if) the data meets the condition you specify, the system retrieves it from the
database for use in a report, manager sheet, auto-creation, data picker, and so on.

Data type & functional area of Unifier, such as
E a Cost Sheet or Resource Manager nst Report
=
HI
+* | Data=source  Sources of information associated with the functional
2 ares, such a3 & WBS aftribute or resource role
E ! # Schedule Sheet
-E Data element Field cortaining the detailz that are part of the
E functional area, such as the status or amount
= #|  Data Picker

If the data
meets the condition;  raTa]
Test the data against . retrieve it fromthe Auto-created
{ conditions you s;:necify} database for use husiness
process

Assignee Filter Query Condition

When you are setting up a business process, you can filter the condition for the assignee
according to:

Contains

Does not contain
Exists in

Does not exist in
Equals

Does not equal
is empty

is not empty

v vV v vV vV v v Vv

The following is an example of query evaluation. The workflow setup follows these policies for
selecting users.

Assignee Query Field (Role as defined in the User
Attribute Form)

Approver

Reviewer

Controller-Approver

Controller

Reviewer-Submitter

MmO |®@|X>

Submitter
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Assignee Query Field (Role as defined in the User
Attribute Form)
G Approver

The following shows examples with condition/operator:

Condition/Operator

Business Process Form
(Field value)

Example of the data source

Filtered List of Assignees

used.

exists in Controller-Approver A C,D,G
Reviewer B

does not exist in Controller A B CEFG

Note: If the workflow setup has any of the new operators, the list of
assignees that the user sees at runtime retains the stated query
parameters.

The following shows examples with value, condition/operator, and result:

Value 1 Condition/Operator |Value 2 Result
ABC exists in ABC, BCD, CDE True
XYZ exists in ABC, BCD, CDE False
ABC does not exist in ABC, BCD, CDE False
XYZ does not exist in ABC, BCD, CDE True
ABC, BCD, CDE contains ABC True
ABC, BCD, CDE contains XYZ False
ABC, BCD, CDE does not contain ABC False
ABC, BCD, CDE does not contain XYz True

Query Based Data Element (QBDE)

A Query Based Data Element (QBDE) lets you view data from the Upper Form or Detail form of

a Business Process. QBDE also lets you view data from:

» Other Business Processes

» Sheets
» Cash Flow
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The QBDEs are based on the “SYS Numeric Query Based” Data Definition (DD), and the query
for these QBDEs is set in the Business Process Configuration setup. For more information, see
Configure a Query for a Query Based Data Element on a BP in the Unifier Modules Setup
Administration Guide.

In addition to the Web interface (Unifier application in the browser), the system evaluates QBDE
in the following areas:

» CSV import for record creation

CSV import for Line Item creation

Web Service methods for record creation along with Line items
Web Service methods for Line Item creation

Web Service methods for record updates

Bulk Edit

Bulk Update

Creating BP records using BP

v v v v vV v Vv

Note: Oracle recommends that you do not use a Required field to create
a query that uses a Data Picker, Cost Breakdown Structure (CBS)
Picker, or Fund Breakdown Structure (FBS) Picker. If the data entered in
a data element (DE) field with a Required condition is cleared, the
system bases the query on the previous value of the field.

Evaluating Query Setups of Data Picker Data Elements

The system supports many types of Data Picker DEs. The Administrator can set up Query
conditions on these Data Picker DEs to filter the results. When a Data Picker DE is launched in
the Web interface, the system runs the query and displays the records based on the queries
defined in uDesigner. The system evaluates the data picker query conditions in the following
areas, as well:

CSV import for record creation

CSV import for Line Item creation

Web Service methods for record creation along with Line items
Web Service methods for Line Item creation

Web Service methods for record updates

v v v v Vv

The following is a list of the supported Data Pickers:

BP Data Picker
Shell Data Picker
User Data Picker
CM Data Picker
Role Data Picker

v v v v Vv
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Note: If a BP Data Picker (BP Picker) or any Data Picker is selected as
a trigger element for QBDE and the picker value is automatically
populated (auto populated) instead of manual entered, the QBDE
element will not be evaluated.

For more information about importing data, see Importing Configuration Packages in the
Unifier Modules Setup Administration Guide.

Creating a Record from the Query Based Tab

When creating a record from the Query Based tab of another BP (that auto-populates data to the
record being created), the Data Element (DE) of type “SYS Numeric Query Based” Data
Definition (any DE of this type) is not updated, unless the user manually changes the trigger
element.

If a query condition involves only constant dates, it is not converted based on the user's
timezone.

Attaching Files

This section outlines the rules for attaching files.

Assuming you have the proper permissions, you may attach files (such as Word documents,
spreadsheets, drawings, PDFs, and so on) to business process forms, cells (such as a Cost
Sheet or Funding Sheet), and Mailbox messages.

» Business Process Forms: If you are creating or participating in a business process
workflow, you can add attachments to the form or to a general comment associated with the
form. Document type BP forms have special file attachment functionality. You can access
the attachments in Workflow task emails under General comments section in the Document
type BP.

Note: The Enable response via email option must be selected.

» Cost Sheet, Funding Sheet, Schedule Sheet Cells: You can add a file attachment to a
cost sheet, funding sheet, or schedule sheet (or most any Primavera Unifier sheet) cells that
have not been auto-populated from a business process. Open the cost, funding, or schedule
sheet and click a cell. The Cell Detail window opens. In the Cell Detail window, click Attach.

» Mailbox Messages: You can attach a file to a Mailbox message. Open a Mailbox message
window and click Attach.

Files can be uploaded and attached from your local system, or they can be attached from
documents already uploaded and stored in the Document Manager.

The file attachment procedures are similar across the system. When an Attach Files option or
Attachments tab is available in a window, it is associated with the ability to attach a file. When
attaching files, you will be presented with two options:

» Browse
» Document Manager
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Antivirus scanning of files

To prevent virus attacks from infiltrating your system through external files, the system scans
each file that is uploaded. Until the scan is completed, the file remains in a Scan Pending state.

At a minimum, the system scans each file that is uploaded, submitted, or attached through the
following channels:

v

v vV vV vV vV VvV v v Vv

Document Manager

Business processes (BPs)

Image pickers

Cells within forms or sheets

Custom Templates for use with custom prints and reports

XML Localization Interchange File Format (XLIFF) files used for translation support
Custom Help files, such as those provided through a uDesigner object

Bluebeam sessions

Webservice Get calls

Import of comma-separated values (CSV) or Microsoft Excel files

Depending on how your environment is configured, the following actions might occur:

»

If the virus scanner detects an issue with a file that a user is uploading, the system sends an
email to the user who uploaded the file and the designated company contact. Depending on

the location of the infected file, the system might display a bug icon ® (if the system is

configured to display alerts) or an ellipsis icon =5 (if the system is configured to prevent the
display of alerts).

If a user tries to access or download a file that has not yet been scanned and the
environment is configured to display alerts, the system displays a Confirmation message that
requires a response to continue. If a Confirmation message appears, the user can wait and
try to access the file later.

If the virus scanner detects an issue with a file that a user is trying to view or download, an
alert is displayed that indicates the file contains a threat. If multiple files were selected for
download, the uninfected files are downloaded.

Note: For more information about the configuration of an environment to
allow the display of messages regarding Scan Pending states, see Edit
Company (Security Tab) in the Unifier General Administration Guide.

Browse Option for File Attachments

If you select the Browse option, a new Upload window is displayed. You can drag and drop files
from your computer to the Drag and Drop box or click anywhere in the Drag and Drop box and
browse your local system for attachments. In the middle portion of the window, there is a File log
that contains the following columns:

»

4
4
»

File Name

File Size
Document Title
Revision No
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» Issue Date

In the lower portion of the window, you are provided with options that pertain to the uploading
process. You can select Revise automatically if file with same name exists. However, unless
you have more than one file with the same name, the Revise automatically if file with same
name exists check box cannot be selected. You can choose whether to upload the files from
your computer, auto-resolve the files from Documents as Dynamic Links, or auto-resolve the
files from Documents as Static Links.

After you select files to upload, click the Upload option in the lower-right corner of the window.
To close the window, click the Cancel option.

Document Manager Option for File Attachments

Files are uploaded to the Document Manager and stored in a folder system. Access permissions
can be applied to individual folders and documents. You can attach documents from the
Document Manager if you have at least view permission on the documents.

Click the Attach button. If you select the Document Manager option, a new Select Files
window opens. This window displays the folder structure in the project or shell Documents
functional node in the Document Manager. Here you can:

1) Open folders to view contents.
2) Select multiple documents or folders to attach.

Notes:

= All documents within folders and subfolders will be attached in a flat
file.

= Documents with duplicate file names will not attach.

You can browse a variety of existing folders from the Document Manager by clicking any of the
folders in the Project Documents log. This log contains the following columns:

» Name
Comments
Location
Owner
Title

Rev. No.
Issue Date
Size

vV v vV vV v v Vv

In the top left corner of the window under the locator links, you can select the Search and Find
on Page options. With the Search option, a new window is displayed where you can search for
a file based on a variety of pre-determined conditions. You can also add conditions as well as
match your search with any or all conditions. After you have entered information into the Search
bar, you can select the Search option to begin the search process. To go back to the previous
window, select Reset.
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With the Find on Page option, you can search for a file or folder within the Project Documents
log. A new row is created at the top of the log, and this row contains search fields for each
column. Upon entering information into the search fields, any matching results are highlighted
and displayed in the log. To restore the log to its original state, clear the search fields by deleting
the entered information.

Notes:

= Folders cannot be selected and documents with duplicate file names
cannot be attached.

= You must have at least view permission to the folders and files within
the Document Manager to view and attach them.

After you select the files, click the Select option in the lower-right corner of the window. To close
the window, click the Cancel option.

If you are creating or participating in a business process workflow, you can add attachments to a
business process form or to a general comment associated with the form. Document-type
business process forms have special file attachment functionality. You can add attachments to a
general comment by selecting the Attach Files option in the Comments tab of a document-type
business process form. The previous Browse and Document Manager options are available.

When attaching files to a business process form, you may be presented with the previous two
options as well as an additional option:

» Browse

» Document Manager

» Custom Print

Custom Print Option for File Attachments

If you select the Custom Print option, then a new Print window is displayed. The window
contains two sections, Custom Print Template and Template and Format. In the Custom Print
Template section, there is a Title heading followed by a text box that displays the specific
Custom Print Template data. In the Template and Format section, there is a Name textbox along
with Template and Format drop-down lists.

Notes:

= A value must be entered into the Name textbox before proceeding.

= If there are no Custom Print Templates available for the business
process, then most of the elements of the window cannot be
selected. The exception to this behavior is the Name textbox.

After you select Custom Print Templates to attach, click the Attach option in the lower-right
corner of the window. To close the window, click the Cancel option.
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Adding Images

In many forms, you can add an image to a business process, project, shell, and so on. For
example, you can add an image that shows progress on the project information record, pictures
of assets related to a specific asset record, or a photo of an employee in the Resource Manager.
You can add images to attribute forms in shells, projects, companies, and BPs.

If the Image picker functionality has been added to your project in uDesigner, forms with the
functionality display the image name and a virtual box that will hold the uploaded image.

Note: The image name is based on the data element name provided in
uDesigner.

To add an image to a form:

1) Click Upload Images in the toolbar at the top of the form.
2) Browse for the image to upload and click OK.
Valid image file types are:

» .Jpg
» .jpeg
» .gif
» .png

» Ltif

You can change the image by replacing it with another uploaded image. Images display on the
HTML or PDF formats of printed forms. They display in print preview as well. The Image picker
can be added to all forms except for those in the Cost Manager, Generic Cost Manager,
Schedule Manager, and Document Manager.

Adding or Updating Hyperlinks

In many forms, you can add a hyperlink to a business process form, project, shell, and so on.
For example, you can add a hyperlink to equipment documentation, details on a resource, or
external websites that contain information pertinent to a business process record. You can add
hyperlinks to attribute forms in shells, projects, companies, and business processes.

If the Hyperlink picker functionality has been added to your project in uDesigner, forms with the
functionality display a hyperlink name, such as vendor website or internal web page.

To add a hyperlink
1) Click the hyperlink area on the form.
2) Inthe Hyperlink window, enter the hyperlink name and the Uniform Resource Locator (URL).

Only the URL is mandatory. If you enter the name and the URL, the hyperlink displays as the
name you entered. If you only enter the URL, the hyperlink displays as the URL. The
protocols HTTP and HTTPS are the only protocols allowed. FTP is not supported for
hyperlink creation on forms.

3) Make sure that the URL adheres to accepted formats, such as starting with an approved
protocol, followed by ://, and then followed by a host name or domain name.
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The system validates the specified URL based on the Uniform Resource Identifier (URI)
provided by the administrator for your organization, if applicable, and on current standards
for URLs.

Examples of HTTP and HTTPS URLs:
http://MyCompany.com
https://YourCompany.net

Examples of URLs that might include URIs authorized for use by your administrator:
ftp://lUserName:Password@MyCompany.edu
ftp://private.ftp-servers.sample.com/MyDirectory/MyFile.txt

Note: The URL should not reference the same domain that Unifier is
using for operation (ask your site administrator if you do not know your
domain name). If you attempt to use the same domain, a warning
message will result.

4) Click OK.

To update a hyperlink

1) Click the hyperlink area on the form.

2) Inthe Hyperlink window, click Clear to remove the existing hyperlink.
3) Enter a new hyperlink name and URL.

4) Click OK.

Note: If you attempt to open a hyperlink to a website that is not
controlled by Unifier, a confirmation window will appear, and you will
need to click Yes to access the external website. If the URL of the
hyperlink is invalid, you will receive an error message and you will not be
able to save the record until a valid hyperlink is added.

CSV File

A Comma-Separated Values (CSV) data file, or a CSV template file, enables you to import or
export data to and from Unifier. Each row in a CSV file corresponds to a new record and each
column is a field to be populated on the form. For more information about importing and
exporting a CSV template, see Importing Data from an Outside Data Source (on page 110).

Note: CSV supports all data definitions.

As an example for how the data is updated by way of a CSV file, the following explains how the
data definition type of "Company Picker" (for example, a contractor's name) is updated in the
CSV template. The update is applicable to both upper form and detail form data elements of the
Company Picker type.

Project-level business process
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When Company Picker exists in a project-level business process, the system checks to
ensure that the value you had entered in the Company Picker field of the CSV template is an
active and valid company. The valid values for the Company Picker are:

»  Owner company

» Member companies in the shell
Company-level business process

When Company Picker exists in a project-level business process, the system checks to
ensure that the value you had entered in the Company Picker field of the CSV template is an
active and valid company. The valid values for the Company Picker are:

»  Owner company
» All active partner companies

Note: In both cases (project and company), if the CSV template contains
an invalid value, then the system displays a message indicating that the
company name is not a valid value for the selected data element.

Exporting a CSV File

When exporting a CSV template, the column headers display according to your Preferences
settings.

» If you enter data for any text type DE, the data is not translated. Example: "Vendor Specialty"
is a text type DE. If the User enters "Electrical Appliances" as the data, then the entry is not
translated according to the Preferences settings.

» You must not include currency and digit grouping symbols when you enter data because the
information is captured as a part of header information and according to your User
Preferences settings. If you enter currency and digit grouping symbols when you enter data,
you receive an error message.

» Ensure that you enter the negative number format with a minus sign at the beginning of the
number: Example: -10000,99 (minus 10000 comma 99). The decimal symbol is a comma)

» If you enter a value in the date field, or in line items, through CSV, the values display
according to your User Preferences settings.

Additional Information about Exporting a CSV File

All error messages, system, custom, or form validation, display according to your Preferences
settings.

The file name of an exported file will not be translated automatically.

When using CSV to import (CSV Import), ensure that you do not remove any of the comments
(including the instructional text) from the CSV file. Removing comments will result in import
failure.

To prevent receiving error messages, do not change the contents or structure of an exported
CSV file.

When comparing strings, the leading or trailing space ("white space" at the end of a line) will be
ignored by the system.
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Example: Consider the following strings:

» A Line Item tab in uDesigner, " Budget Details " (with leading and trailing spaces)
» Three CSV import templates:
» "Budget Details " (with a trailing space)
» "Budget Details" (No trailing or leading spaces)
» “ Budget Details” (with a leading space)
Result: The system will trim the spaces if needed (“Budget Details. " the space between the

period and close quotation, and interpreted as “Budget Details”) and this value will then be
compared with the uDesigner tab hame “Budget Details”.

The following lists the impacted modules:

CSV Import for all Business Processes for record creation

CSV Import under CM - Code and Records-based manager for record creation
CSV Import under Planning Manager for record creation

CSV Import under Portfolio Manager for record creation

CSV Import under Shell Manager for record creation

CSV Import under Space Manager for record creation

CSV Import under User Administration for record creation

Line Item import for Line Item creation

Vv vV vV vV vV vV v Vv

Exporting a CSV File with or without an Import

When you export a CSV data file from the sheet, the numeric fields display according to your
Preferences settings (the number format options settings). The following provides additional
information:

» In functionalities that allow export and import of data through a CSV file, the currency symbol
and digit grouping symbol are not displayed.

» In functionalities that allow only exporting of data but not importing data through a CSV file,
the currency symbol and the digit grouping symbol are displayed.

» In Unifier functionalities that allow only exporting of data but not importing data through a
CSV file, the negative numbers display according to your Preferences settings.
Decimal symbol display according to your Preferences settings.
In functionalities, which allow exporting and importing of data through a CSV, the negative
numbers, if any, displays as: -<Number, Decimal Symbol, Number> (Example: -100000,99 -
The decimal symbol is comma)

» If there are any date fields, then the dates are formatted based on your Preferences
settings.

Importing a CSV Template Data File

If importing a CSV data file (Example: Importing Column details), the column data appears
according to your Preferences settings.
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»

»

You do not need to enter the Currency symbol manually because the symbol is included in
the header. Entering the Currency symbol manually generates an error message.

When importing a CSV file is complete, the number formatting displays according to your
Preferences settings.

When importing a CSV file is complete, the date formatting displays according to your
Preferences settings.

Oracle recommends that you use custom data elements for defining queries for a data picker
filter condition. You can use the auto-populate in order to get the shell name or other shell
properties populated on the record for the required custom data element.

Note: Oracle recommends that you use custom data elements for
defining queries for a data picker filter condition. You can use the
auto-populate in order to get the shell name, or other shell properties, to
get populated on the record for the required custom data element.

List of Impacted Sheets and Modules

The following is a list of impacted sheets and modules:

VvV vV vV vV vV vV vV v v v

Cost Sheet

Funding Sheet

CM sheet

Generic Cost Sheet

Planning Sheet

Summary Fund Sheet
Summary Budget

CBS Details

Column Details

Data Definitions (DDs) export

List of Modules Only Impacted by Exporting

In Unifier functionalities that allow only exporting of data but not importing data through a CSV
file, the column headers and the Data Element (DE) labels display according to your
Preferences settings. The following shows a list of modules impacted by exporting, only:

4
4
4
»

Basic data definitions under Data Structure Setup
Cost Codes under Data Structure Setup

Data Elements under Data Structure Setup

Data Picker under Data Structure Setup

Importing Data from an Outside Data Source

The Unifier integration feature imports data from an outside data source. Using this feature, you
can import data from an outside application, such as an accounting system, and thereby, create
records and line items. Importing is most effective in cases where you want to populate Unifier
with a large amount of information that exists in the other system.
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This section discusses importing data using CSV files. You can use CSV files to create records
and line items for business processes and most of the Unifier managers. It is largely useful for
transferring a company's legacy data.

After you have edited and saved the CSV file, you can import it back into the system to create
the new records or line items. During the import process, the system validates the data. If the
data passes validation, the new records or line items will be created. If the data fails the
validation, you can view or download a text file summarizing the errors, and locate the erroneous
records in the csv file.

To use this feature, the business process or manager must include an integration interface that
was designed in uDesigner. Separate integration interfaces are designed for each BP or
manager, each specifying what fields will be populated when the new records or line items are
created.

Note: New records can also be created by XML integration via Web
Services. For more information about Web Services integration, refer to
the Unifier Integration Interface Guide. XML integration via Web Services
must be coordinated with Primavera Unifier Consulting Services.

The integration interface feature supports:

Cost BPs

Line Item BPs

Simple BPs

Text BPs

Document BPs

Code and Records-based configurable manager classes
Planning Manager planning items

Shell Manager shells

Shell creation BPs

vV vV vV vV vV VvV v v Vv

Overall Steps for Importing Data

Here is an overview of the steps involved in importing data from CSV files to create new records
and line items.
1) Export the CSV template file to your machine.

The CSV file contains the correct integration structure, with each row corresponding to a new
record, and each column a field to be populated on the form.

2) Modify the CSV file.
Add new record data into the template CSV file, one record per row.
3) Import the modified CSV file.

After completing the CSV file, you can then import it back into Unifier to create the new
records or line items. During the import process, the system validates the data. If the data
passes validation, the new records or line items will be created. If the data fails the validation,
you can view or download the CSV file with the error summary.
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Note: The import process runs in background, allowing you to continue
your work during the import and validation process. The amount of
records being imported will affect the processing time. You will be
notified by email once the process is complete and the records have
been imported or errors have occurred.

Exporting the CSV Template to Your Machine (Integration)

To export an integration template:

Note: To prevent receiving error messages, do not change the contents
or structure of an exported CSV file.

1) Display the toolbar with the Export button using the table below.
2) Click the Export Template button and choose CSV.
3) Save the CSV file to your local drive.

To display the toolbar for this: Do this:

Select the name of the BP wherever it
resides in the Navigator: in the Company
Logs node, the General log node, or Data
Manager log node.

A business process at the company level

Select the name of the BP wherever it

A business process at the project/shell resides in the Navigator: in the Project
level Logs node, the Information > General log
node, or the Data Manager log node.

In the Planning Manager node of the

A planning item Navigator, select the planning item.

A class for a Code and Records-based In the [Manager] node of the Navigator,
configurable manager select the class.

When comparing strings, the leading or trailing space ("white space" at the end of a line) will be
ignored by the system. The following is an example. Note the presence or absence of space in

the example:

» The Line Item tab name in uDesigner - “ Budget Details ”

» The CSV import template may have “Budget Details ”, “Budget Details”, or “ Budget Details ".
» The system will trim the spaces if needed (“Budget Details. " the space between the period

and close quotation will be trimmed and interpreted as “Budget Details”) and this value will
be compared with the uDesigner tab name “Budget Details”.

Editing the CSV File

Each row in a CSV file corresponds to a new record, and each column is a field to be populated
on the form.
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Note: Do not add, move, or delete the columns in the CSV file.

To edit the CSV file:

1)

2)

3)

4)

5)

Open the CSV file in Microsoft Excel or a compatible application, such as a text editor or
Notepad.
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To add header (upper form) data to the file:
a. Move your cursor to an empty line and type an H in column A.

b. Press the Tab key to move to the next column and enter the value that you want to import
for that field.

c. Repeat step b for all the fields in the row.
To add detail form data to the file:
a. Move your cursor to an empty line and type a D in column A.

b. Press the Tab key to move to the next column and enter the value that you want to import
for that field.

c. Repeat step b for all the fields in the row.

If you have additional line item data that needs to be imported, repeat step 3 and its
sub-steps until you have entered all the line items you want to import.

Save the file.

Importing CSV File into Unifier

After you have edited and saved the CSV file, you can import it back into Unifier to create the
new records or line items. During the import process, the system validates the data. If the data
passes validation, the new records or line items will be created. If the data fails the validation,
you can view or download a text file summarizing the errors.

To import the file

1)

Display the toolbar with the Import button as shown in the table below.
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2) Click the Import button. The File Upload window opens.
3) Fillin the fields on the File Upload window and click OK.
The system checks the import process to verify that valid records were created. Specifically,

it validates that:

» The import file format matches the integration interface design that was created in

uDesigner.

» The imported data is for the correct BP (that is, that the data was imported into the same
log as that from which you exported the CSV template file).

» The imported data is correct; that required fields contain data in the correct format, the
data type is correct, the correct values were added for drop-down lists, and so on.

To display the toolbar for this:

Do this:

A business process at the company level

Select the name of the BP wherever it
resides in the Navigator:in the Company
Logs node, the General log node, or Data
Manager log node.

A business process at the project/shell
level

Select the name of the BP wherever it
resides in the Navigator:in the Project Logs
node, the Information > General log node,
or the Data Manager log node.

A planning item

In the Planning Manager node of the
Navigator, select the planning item.

A class for a Code and Records-based
configurable manager

In the [Manager] node of the Navigator,
select the class.

Using CSV File to Import Attachments

You can use a CSV template file to import attachments into Unifier, when you are creating a BP

Record, or Line Item.

Note: To prevent receiving error messages, do not change the contents

or structure of an exported CSV file.

Example

There are 20 line items in a single record (Line Item type BP) and each line has an
attachment. You can use a CSV template to include the names of all the attachments (for
that single record) and import, or upload, all the attachments into Unifier.

For details on how to import a CSV file back into Unifier, see Importing CSV File into Unifier.

The last column of the CSV template is a placeholder for the file names of the attachment (the
file that you want to attach to the BP Record, or Line Item). If you have more than one file to
attach, you can enter the names of each attachment separated by a colon (:), for example,

Attachmentl.pdf:Attachment2.pdf:Attachment3.pdf.
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If you enter the same name in the Attachment cell twice, the system ignores the duplicate and
only uploads a single file.

If there is no data in the placeholder column of the CSV template file that is getting uploaded,
then the system processes the CSV template upload as a file without any attachment.

If you keep two attachments with the same name in the CSV file, then the system attaches the
same two attachments to all the Item Lines referencing that name.

If you upload a file twice, then the system overwrites the attachment that is present in the review
section.

The Attachment section of the CSV upload wizard lists attachments that are ready for upload
(Ready to be uploaded). As you keep uploading the attachments on the Attachment section, the
status of the files keep changing to Ready to be uploaded.

Note: For security, the Company Administrators can specify the list and
size of files that can be uploaded to the Company Properties page, by
users and per company policy. Contact your Company Administrator for
more information.

When comparing strings, the leading or trailing space ("white space" at the end of a line) will be
ignored by the system. The following is an example. Note the presence or absence of space in
the example:

» The Line Item tab name in uDesigner - “ Budget Details ”

» The CSV import template may have “Budget Details ", “Budget Details”, or “ Budget
Details .

» The system will trim the spaces if needed (“Budget Details. " the space between the
period and close quotation will be trimmed and interpreted as “Budget Details”) and this
value will be compared with the uDesigner tab name “Budget Details”.

Upload CSV and Add Attachments

When the Upload CSV wizard opens, you can select the file manually (Add) or choose to drag
the file onto the page. After uploading the CSV file, click Next to go to the Add Attachments
page.

Note: After you upload the required files, the status of each file changes
to Ready to be Uploaded.

For BP Record import

» The system does not check whether the file attachment is allowed (set on the integration
form) for the BP Record.

» If there are files referenced in the Attachments column of the CSV file, but the files are not
uploaded in the Add Attachments section, then the system provides two options:

» Select OK if you want the system to ignore the files referenced in the Attachments
column of the CSV file. The system creates the BP Record without the attachments.

» Select Cancel to navigate back to the CSV file and upload the attachments.
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Note: Oracle recommends that the total number of line items included in
the CSV file not to exceed five thousand (5000), for better performance.

For Line Item import

» The system does not check whether the file attachment is allowed (set on the integration
form) for the Line Item.

» If the CSV file upload is restricted for the Line Items tab, then the system disables the
Upload Attachments and you are able to upload the CSV file.

» If there are files referenced in the Attachments column of the CSV file, but the files are not
present in the Attachment upload, then the system provides two options:

» Select OK if you want the system to ignore the files referenced in the Attachments
column of the CSV file. The system creates the Line Item without the attachments.

» Select Cancel to navigate back to the CSV file and upload the attachments.

The CSV file attachment process starts when you click Upload, in the Add Attachments window.
If there are any validation errors, the system displays a pop-up window after you click Next on
the Upload CSV page window.

For Document-type BP

» The system only processes the attachments referred to at the Line Item level (D level in the
CSV file).

» If you reference an attachment at the BP Record level (H level in the CSV file), the system
ignores the attachment that is available on the Attachments window of the CSV upload
wizard.

For Text-type BP

» The system ignores all attachments included in the CSV file and the attachments do not
appear on the Attachments window of the CSV upload wizard.

Blocked file extension

The system prevents uploading of file attachments with blocked extensions, as configured by
your Site Administrator (System Administrator).
Audit log

» If a CSV import of a BP record occurs, if an attachment is uploaded during creation, then the
system does not audit the attachment.

» If a CSV import of a Line Item occurs, the system does not audit the attachment.

Internationalization and CSV Files

Importing and exporting data can be done by using a Comma-Separated Values (CSV) data file
or a CSV template file. This section explains how the availability of different languages
(Internationalization) impact the various CSV files created, used, imported, or exported.

Note: Number formatting is not supported for Symbols that are based on
a right-to-left language such as official languages of Afghanistan or
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Hebrew.

Generic CSV files

Language preferences are detected from the Preferences settings (Region Format), for both
CSV data files and CSV template in:

» All column headers
» All informational text

If importing a CSV file fails, the import error file displays the system generated error messages in
the preferred language.

If importing a CSV file fails because of form validation errors, then the custom error message
displays the message in the preferred language.

Notes:
= If translation is not available for a custom error message, then the
source string is displayed.

= Before importing a CSV file, always check the Preferences settings
to see the allowed format and number formatting.

= When importing, or exporting, a CSV file, the date format follows the
Preferences window (Region Format) Date Format settings.

Additional information about exporting and importing CSV files

When importing and exporting of a CSV file is conducted by users with two different language
settings (for example, French and German), the data entered into an exported file must match
the original language set.

Example

The CSV template Export has been done in French and the template is being used by a
German User. If the German User enters data without changing the column structure and
Imports the file, the Import action will fail and an error message will appear in German,
indicating the error.

Internationalization and Web Services

About Web Services

New records can be created and line items can be added using Integration through web
services. Also, the Schedule Manager integrates with Primavera scheduling software by way of
web services.
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Note: Integration through web services must be coordinated with an
Oracle Primavera representative.

As Project Administrator, you can receive email notification of the successful creation of a shell
instance, for shells that are created manually, through web services or a CSV file upload, or
through auto-creation. This naotification can be set up in email notifications in uDesigner. Also,
you can set your Preferences to control whether you receive these notifications.

Web Services and Internationalization

The output data generated by web services is always in the source language.

Note: If a record (Example: Business Process) is created by using web
services and the Data Definition (DD) label includes a non-ASCII string,
then the record creation will fail.

Number formatting of data

When you enter numeric data in XML, you can only use the decimal point (period) and
negative sign (dash).

Examples
XML Tag: <Committed  Amount>100.99</Committed_ Amount>
XML Tag: <Credited_Amount>-1423.99</Credited_ Amount>
Sample JSON request
"data": [
{
"uuu_quantity': 6000.258,
"amount'': -27600.0,
}

When you run a Get call, the input content in the response XML or JSON will be in the
language of the source strings.

Get Web Services

You can use the Get Web Services call methods to get various attributes of Shell, CBS, and
the list of Business Process records, Shells, and User defined data.

When you run a Get call, the input content in the response XML will be in the language of the
source strings.

Number formatting does not apply to the numeric data and the decimal point is a period. The
negative numbers are displayed with the minus sign before the numeric data, for example,
-12345.99.

Note: Number formatting is not supported for Symbols that are based on

a right-to-left language such as official languages of Afghanistan or
Hebrew.
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Searching and Finding in Unifier

You can use the Search and the Find on Page options to search for specific items in:

» Business Processes
» Manager sheets
» Pickers

You can also use the Search and the Find on Page options to search for a design in uDesigner.

When you use the Search and the Find on Page options, the system narrows the list of items
shown on a sheet, or picker, to match the search criteria you specified.

The Search and the Find on Page options show fields from the sheets, or pickers, that you can
use to narrow the list of items you see. For example, for pickers with extensive lists, this can
make completing the business process form much quicker.

The fields that appear in the Search and the Find on Page options are usually specified in
uDesigner when the forms are designed for the business processes, managers, and pickers.

Note: Some logs, such as the Mail logs, use "canned" Search and Find
on Page windows because these logs are not designed in uDesigner.

Searching and Finding: Search Option

The Search option lets you search specific elements of a business process (BP), BP log, sheet,

picker, and so on. Upon clicking the Search icon ( Q) in the toolbar menu of a BP, BP log,
sheet, or a picker, the Search window is displayed. You can move the window around the right
pane in a horizontal or a vertical motion depending on if the window is docked at the bottom or
to the right. The Dock Right/Dock Bottom option allows you to adjust the positioning of the
window.

This Search window contains advanced search features that change depending on the function
that you are working in. Unlike the Find window in Classic View, the Search window does not
have a Save option that allows you to save your search. When you modify the previous search
fields, you can click the Apply option to save those modifications. The Clear option resets the
search fields back to their default values.

Similar to the previous Find window, the search fields often contain changeable operators, like
“contains” or “equals,” which you can use to further specify the items you want to see.

Like Classic View, some of the search fields contain Select drop-down lists where you can
choose from a list of values. Some of these lists allow you to select multiple values as you click
the items. If you select multiple values, then the search will contain results that match any or all
of the values that you selected.

If you are searching a BP log, you can also use the wildcard characters percent (%) and
underscore () to refine your search. The percent character represents any number of
characters, including letters, spaces, numbers and so on; the search returns all results that
contain the search string. The underscore character represents one character.
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Searching and Finding: Find on Page Option

The Find on Page option enables you to find specific elements of a BP, sheet, picker, and so
on. Upon clicking the Find on Page icon in the toolbar menu of a BP, sheet, or a picker, a new
row is created within the log. Unlike the Search option, the Find on Page row appears at the top
of the log and therefore cannot be moved.

This Find on Page row contains search fields that change depending on the function that you
are working in. Unlike the previous Find window in Classic View, The Find on Page row does
not have a Search option that initiates the searching process. Instead, the searching process
begins immediately upon entering information into the search fields in the row.

Unlike the previous Find window, the search fields do not have changeable operators, like
“contains” or “equals.” Similar to the Search option, Find on Page also does not have a Save
option that allows you to save your search.

When you enter information into the search fields, any matching results are highlighted and
displayed in the log. To restore the log to its original state, clear the search fields by deleting the
entered information.

Searching and Finding a Shell

Since shell hierarchies can be extensive, you can use the Search ( Q) feature to locate specific
shells.

You can search for a shell by using either the Geocode Search parameters or the Shell
parameters.

To search for a shell by using the Geocode Search parameters:
1) Go to the home dashboard of the shell (anchor shell) that contains the shell you want to find
(the top node in the left navigator.)
2) Click the Workspaces tab.
3) From the toolbar in the left pane, click Search ( Q) to open the Search window. The Search
window has the following options:
» Clear
»  Apply
» Dock Right / Dock Bottom
» Close
4) Scroll down and enter values in the fields under the Geocode Search section.
Select an address or a latitude and longitude.
» Inthe Address field, enter a full or partial address for the shell.
» Inthe Latitude and Longitude fields, enter the values, if you know them.

If you do not know the latitude and longitude, then you can select the View Map option
(Co-ordinates) to open the Geocode (Latitude/Longitude) Picker window.

» Select the Address, City, State, Country, Postal Code field and enter a full or partial
address.
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» To see the location on the map displayed in the window, you can select the Map It
option. The system fills in the Decimal Degrees for the latitude and longitude as well as
the Degrees, Minutes, and Seconds. The Map It option is also available for Decimal
Degrees and Degrees, Minutes, and Seconds. To clear the fields, select the Clear
option.

» Click the Done option to go back to the previous Search window. The system fills in the
Latitude and Longitude fields in the Search window.

» Inthe Search window, you can enter a value in the Radius field to specify a search
radius surrounding the address or latitude and longitude coordinates.

5) When finished, click Apply.

6) When you finished finding the shell, click the Cancel Search button at the bottom of the log
to return the dashboard to normal view.

To search for a shell by using the Shell parameters:

1) Go to the home dashboard of the shell (anchor shell) that contains the shell you want to find
(the top node in the left navigator.)

2) Click the Workspaces tab.

3) From the toolbar in the left pane, click Search ( Q) to open the Search window. The Search
window has the following options:

» Clear
»  Apply
» Dock Right / Dock Bottom
» Close
4) Enter values in the fields under the Shell section.

For all the fields in the Shell section, you can change the "contains" and "equals" values to:
does not contain, equals, does not equal, is empty, and is not empty, respectively.

5) When finished entering values, click Apply.
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6) When you finished finding the shell, click the Cancel Search button at the bottom of the log
to return the dashboard to normal view.

Searching in Managers Logs

Most manager logs, including Configurable Modules logs, display a static Search window in
order to enable you to find information. See Searching and Finding: Search Option (on page
119) for more details.

The Document Manager and Shell work differently and are explained separately. See the
following sections for details:

» Searching and Finding a Shell (on page 120)

122



Getting Started with General Operations

» Searching in Document Manager Node
In most manager logs, you will be searching for Sheets.
The following managers use the Classic Find button:

» Resource Manager
» Schedule Manager

To search in most manager logs:

1) Go to the Company Workspace tab, or open the Project/Shell where the manager resides.

2) Inthe left Navigator, click the manager grouping node you want to search. The manager
expands to list functional sub-nodes.

3) If there are functional sub-nodes in the Navigator, click the functional sub-node you want to
search.

4) Click the Search button in the toolbar.

The system displays a Search window. The window will display different fields, depending on
how the manager has been designed.

5) Enter your search criteria and click Apply (or press Enter on your keyboard). The system
displays all the items that meet the search criteria you entered.

Searching in Document Manager Node

For more information on searching, see Searching Content in the Unifier Managers User
Guide.

Searching in Document Manager Sub-Nodes
You can access the Document Manager grouping node from:

» Project (User mode)
» Company Workspace (User mode)

In both the Company Workspace and the project (User mode), the Document Manager
grouping node contains the following functional sub-nodes:

» Documents
» Recycle Bin
» Unpublished Documents

The following applies to the search and find features in both project and Company Workspace
Document Manager functional sub-nodes.

Search

The Search window enables you to search for document properties or contents.

1) Click to expand the Document Manager grouping node in the project (User mode).
2) Click Documents functional sub-node to display the Documents log.

3) From the toolbar menu, click Search ( Q) to open the search window. The Search window
enables you to search for document properties or contents. Some of the options are:
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» Content

» Linked Records
» Name

» Title

» Description

Find on Page

Use Find on Page to narrow your search in the records displayed within the log.

1)
2)
3)

4)

Click to expand the Document Manager grouping node in the project (User mode).
Click Documents functional sub-node to display the Documents log.

From the toolbar menu, click Find on Page to open a new row in the table (log columns)
within the Documents log.

Enter values in the fields to narrow your search in the records displayed within the log.

Supported Documents

The following is a list of supported documents for content search:

VvV VvV vV vV vV vV vV v v Vv

Microsoft® Word Document (.doc/.docx)
Microsoft® Excel Document (.xIs/.xIsx)
Microsoft® PowerPoint Document (.ppt/.pptx)
Microsoft® Project (.mpp)

Rich Text Format (.rtf)

Adobe Portable Document Format (.pdf)
Hypertext Markup Language (.html)

Extensible HyperText Markup Language (.xhtml)
Plain Text files (.txt, .java, .bat, and so on)
Document formats supported by Apache Tika 1.3

Indexing and Content Search

The following contains general information about indexing and content search:

Unifier uses Lucene StandardAnalyzer 2.9.3 to index and search the documents.

The following contains examples, and a brief explanation, of how a document or phrase is
indexed and searched:

»

If a document contains the sentence "The quick brown fox jumped over the lazy dog," it will
be stored in index using the tokens: [quick] [brown] [fox] [jumped] [over] [lazy] [dog]. When
you search for the string, "fox," the document will be found.

If a document contains the sentence "server.local.port=7001," it will be stored in index using
the tokens: [server.local.port] [7001], so if you search for the string, "server," the document
will not be found. In this case, you must search for the string, "server.local.port" to get this
document in the search results.

The phrase "XY&Z Corporation - xyz@example.com" will be indexed as [xy&z] [corporation]
[Xxyz@example.com].
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In case of xml files, only the element content will be indexed. The tag and attribute value will not
be indexed and cannot be searched. See the following example:

<?xml version="1.0" encoding="UTF-8"?>

<!l-- in the project's Project Properties dialog box.-->

<project name="Unifier913" default="default" basedir=".">
<description>Builds, tests, and runs the project Unifier913.</description>

</project>

In the example above, the xml file will be indexed as [builds] [tests] [runs] [project] [unifier913]. If
you search for the string, "description,” then the document will not be returned, but if you search
for the string, "project," you will get the document since the string "project" is a part of the
element content.

The indexing background job is scheduled to run every 15 minutes. The documents added to
Document Manager are available for search every 15 minutes after being added.

Note: In the case of Unpublished documents, only the attachments will
be searched. The record information PDF will not be searched.

Document Index Migration

After the server is restarted, the indexer job starts re-indexing for all of the documents to migrate
the index from Lucene 2.9.3 to Lucene 4.0 format.

Note: The re-indexing job takes 2 to 3 days to complete, depending on
the number of files that need to be re-indexed. If you conduct a
document search during the re-indexing job, you may receive an error
message asking you to wait until the job is completed.

Searching Date Fields

The floating Find window provides comprehensive search criteria for date fields. If the date field
on the Find window includes an operator, you may have the option of making the search
relevant to today's date.

For example, for a date field, such as a Payment Due Date, you could specify that the value in
the field should be greater than or equal to the date you pick from the calendar, today's date, or
today's date, plus or minus the number of days entered in the Days field.

Another example might be that the value in the field should be between today's date and today's
date, plus or minus the number of days entered in the Days field.

Floating Find windows display search results that include a banner across the top of the window.
This banner indicates that the list has been searched, or filtered. To restore the list of records to
its unfiltered state, click Cancel Filter in the banner.
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Searching Mailbox Log, Notifications Log, and Sent Items Log (Home Workspace)

In the Home workspace, you can access the following functional nodes:

» Inbox
» Notifications
» Sent ltems

Inbox

To search the Inbox, click the Inbox functional node and in the Inbox log click the View
drop-down list. The View drop-down list enables you to search in the Inbox by adjusting the log
view and using the following options:

» Received in last 7 days
» Received in last 30 days
» Group by Origin

» Group by From

» All ltems

You can use the Search icon ( Q ) to open the Search screen and determine the values for the
columns in the Inbox log by:

» Field

» Operator
» Value

The Search screen also enables you to determine the number of records that you want to be
displayed on the Inbox log.

The right hand side, next to the Inbox log, shows the contents of the email that is highlighted on
the log.

See the Home Workspace (on page 43) topic for more details.

Notifications

To search the Notifications, click the Notifications functional node and in the Notifications log
click the View drop-down list. The View drop-down list enables you to search in the Notifications
by adjusting the log view and using the following options:

Received in last 7 days
Received in last 30 days
Group by Business Process
Group by Origin

All Notifications

v v v v Vv

You can use the Search icon ( Q ) to open the Search screen and determine the values for the
columns in the Inbox log by:

» Field
» Operator
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» Value

The Search screen also enables you to determine the number of records that you want to be
displayed on the Notifications log.

The right hand side, next to the Inbox log, shows the contents of the email that is highlighted on
the log, if you have permission to view.

See the Home Workspace (on page 43) topic for more details.

Sent Items

To search the Sent Items, click the Sent Items functional node and in the Sent Items log click
the View drop-down list. The View drop-down list enables you to search in the Sent Items by
adjusting the log view and using the following options:

Sent in last 7 days
Sent in last 30 days
Group by Origin
Group by To

All ltems

v v v v Vv

You can use the Search icon ( Q ) to open the Search screen and determine the values for the
columns in the Inbox log by:

» Field

» Operator

» Value

The Search screen also enables you to determine the number of records that you want to be
displayed on the Sent Iltems log.

The right hand side, next to the Inbox log, shows the contents of the email that is highlighted on
the log.

See the Home Workspace (on page 43) topic for more details.

Searching Sheets

Most manager sheets will have a Find on Page button ( 53 ) to search for data within the
individual columns of a sheet.

To search a sheet
1) Open the sheet.
2) Click the Find on Page button. Find fields appear above each column.

3) For each column you would like to search, enter the value you are looking for in each Find
field. If the system finds the value, it will highlight the value on the sheet and hide all rows
that do not contain that value.
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Searching Pickers

Most pickers include a Find feature with which you can locate specific objects (codes, assets,
business processes, users, shells, and so on) while you are working on a form or a sheet . When
you use this Find feature, the system narrows the list of items shown on the picker to match the
search criteria you specified. For pickers with extensive lists, this can make completing the
business process form much quicker.

Some pickers display static Find windows; others display floating windows like the Task and
business process logs (however, without the "save search" feature).

For most pickers, the Find feature works as generally described under Searching and Finding:

Search Option (on page 119) and Searching and Finding: Find on Page Option (on page
120); however, the User/Group Picker works differently.

Notes:

= Fund Pickers are most often searchable by the fields that were
created for the fund attribute form in uDesigner. However, if no
attribute form was created for the fund, you can search for the fund
by its name or code.

= Pickers that include CBS codes display information generated from a
sheet (the cost sheet or an SOV). Consequently, the Find feature on
the CBS Picker, Commit Line Item Picker, and SOV Picker works the
same way as it does on manager sheets. For instructions on using
these pickers, see Searching Sheets (on page 127).

To find a user in the User/Group Picker
1) Open the User/Group Picker.

2) The List Names from field shows the project/shell or company from which the users' names
will come. (This field is editable only by your company Administrator.)

3) Use the Show By field to restrict the search to users only, to groups only, or to both.
4) Inthe Search for field, enter a name, or partial name.
5) Click Search or press Enter.

The system uses the filters at the top of the Find window and searches the picker list
according to the project/shell, or company specified in the List Names from field, as well as
the Show By option you specify (users, groups, or both).

The system displays on the picker the names that met the search criteria you entered, and
also displays above the list this line: Current View: <filtered by ...> [Cancel Filter].

Note: If you choose to, you can cancel the search action by clicking
[Cancel Filter]. The system will restore the picker list.
User/Group Picker and type-ahead

In the “To” or “Cc” fields (mail recipients) or in the Edit Permissions (log level) and other fields
(where user and groups are both supported), when you enter a value the system includes both
users and groups:
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» If a user is displayed in the type-ahead, then the name is prefixed with the user's profile.
» If a group is displayed in the type-ahead, then the name is prefixed with the group icon.
Example
"Enter a <Display Element's column name> ..."

In the unlikely case of display element not being present in the log, the placeholder text will
be "Enter a <Display Element label>..."

Internationalization

The process of adapting Unifier services to specific local languages and cultures:

The following topics explain the process of planning and implementing Unifier services so that
they can be adapted to specific local languages. These services include:

» Email notifications

» Tools

» Oracle Business Intelligence Publisher (Bl Publisher) and Oracle Analytics Publisher Custom
Reports

Dashboards

Help files

Spell check

Date and time zone formats

Audit log

v v v v Vv

Internationalization (Email Notifications)

When the system generates an email notification, the language used for that email is based on
the recipient's Preferences.

Email notifications for scheduled User-Defined Reports (UDRS), Gates, and so forth, have two
components:

> Text
» Attachments

If a Business Process (BP) email notification contains an attachment with the record information,
then the Custom Strings and number formatting in the attachment is according to the
Preferences.

If a scheduled UDR is sent as a part of an email attachment, the language in the PDF
attachment is according to the Preferences of the UDR owner; however, the email text content
is according to the recipient's User Preferences.

When a UDR is generated manually and saved by a User, the language in the PDF attachment
is according to the Preferences of the User who generated, or ran, the UDR.

If a scheduled job such as Project Gates, where the "Auto-email as PDF attachment to users
and groups" option is selected, the language in the PDF attachment is according to the User
Preferences of the creator of the job (Project Gates creator).
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When a manual refresh of the Gates is requested, the language in the PDF attachment is
according to the Preferences of the User who requested the refresh.

Internationalization (Support for Tools)
When used within the system, the following tools support internationalization:

» Oracle Map
» AutoVue Server
» Flex replacement (O charts)

Note: The Unifier Plug-ins do not support internationalization.

Oracle Map viewer supports internationalization for Tier 1 languages. Refer to the Oracle Map
Viewer User Guide for more details.

The language displayed in the map, and the following subsequent areas, is according to the
language selected in the Preferences of the user:

» View map for BP records from log

» Shell Landing Page

» Map Picker in Log Find

» Map Picker in Bulk Edit

» View Map when invoked from the BP record

Note: eLocation services, which is used for geocoding, does not support
internationalization. As a result, the map labels are displayed in English.
If a User enters a label in a different language, the Find feature does not
provide the desired results.

Internationalization (Bl Publisher/Oracle Analytics Publisher Custom Reports)
The BI Publisher/Oracle Analytics Publisher Reports support internationalization as follows:
Custom Report (Report File tab) window

If there are no templates available for the report, the Custom Report window (Report File tab)
displays according to the default settings.

To upload the translated XLIFF files and report layout, click Add to open the Add Template and
Files window, enter data in the required fields, and click OK.

Notes:

= The non-RTF templates do not support internationalization.

= You can only change the template type when the template is in
Creation stage. After you create a template, you cannot change the
template type. Use the report designer to create a template with the
desired template type and remove the template that is no longer
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needed.

In the Custom Report window (Report File tab), the only editable column is the Default column,
which lets you set the default template by selecting (check-box) the corresponding template.

Note: The system sets the first template, or XLIFF file, that you upload
as the default template.

Use Modify in the Custom Report window (Report File tab) to modify an existing template. After
you click Modify, the Modify Template and Files window opens, which lets you modify the
template and the translated XLIFF file for that template. When finished, click OK.

Use Download in the Custom Report window (Report File tab) to download a template and the
corresponding translated XLIFF file, in a zip file.

External Data Model Bl Publisher/Oracle Analytics Publisher Reports

If you want to download the data model of a template, select the template, and click Download
in the Custom Report window (Report File tab). When the download is complete for an External
Bl Publisher/Oracle Analytics Publisher report, the data model is included.

Non-RTF type template

Bl Publisher/Oracle Analytics Publisher supports RTF templates and XLIFF files. If the report
designer selects a non-RTF type template, the Browse option in the Modify Template and Files
window (Translated XLIFF files for the Template section) will be disabled.

Custom Report (Query tab) window

Queries based on Data Definition (DD) support internationalization and number formatting
associated with internationalization according to the Preferences settings.

Queries based on Data Views do not support internationalization and formatting because raw
data is being used.

Queries based on Ad-Hoc support internationalization and number formatting associated with
internationalization according to the Preferences settings.

Internationalization (Dashboards)
Shell Dashboards

The Shell Dashboards support Internationalization and number formatting for System Strings as
well as Custom Strings according to the Preferences settings.

Internationalization (Help Files)
Unifier Help files do not support Internationalization and are not translated.
Note: You can translate the Help files, using a third-party translator, and

display the files based on your Preferences settings. This includes
uploading a single PDF with multiple language help information.
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Internationalization (Spell Check)

The Spell Check feature does not support Internationalization.

Note: If the language selected in your Preferences is not English, the
Spell Check option will not be available.

Internationalization (Date and Time Zone Formats)
Date formats
The following additional date formats support Internationalization:

MM/DD/YYYY
DD/MM/YYYY
MM/DD/YY
DD/MM/YY
MM-DD-YYYY
DD-MM-YYYY
MM-DD-YY
DD-MM-YY
DD.MM.YYYY
YYYY-MM-DD
MMM/DD/YYYY
DD/MMM/YYYY
YYYY/MMM/DD
M/D/YYYY
M/D/IYY
D/MIYYYY
DIMIYY

YYIM/ID
YYYY/M/D
YY/MM/DD
YYYY/MM/DD

Time Zone formats

VWV VvV VvV VvV VvV ¥V ¥V VvV VvV vV VvV VvV VvV vV vV VvV VvV vV v v v

The Time Zone setting is based on the Coordinated Universal Time (UTC) and supports
Internationalization.

Note: The time format for all dates is;: HH:MM AM.

Internationalization (Audit LoQ)

Within the Audit log, the following columns support Internationalization according to the
Preferences:
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» Event
» Description
» Field

System and custom strings can be translated for Event, Description, and Field columns.
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P6, Unifier, and Gateway

Unifier uses the Rate Sheet object in Gateway, with canned fields, for connecting Rate Sheet
with P6.

An out-of-the-box (OOTB) Unifier Object, "Rate Sheet" (in Gateway), contains all the canned
fields present under the Master Rate Sheet in Unifier.

In This Section

Gateway Data DICHONAIY ..........uuuuuiiiiiiiiiiiiiiiii e 135
Gateway Field MappingS .........uuuuuuuuuuuiiiiiininiiiiininei e 136
RESOUICE Data frOmM PO ........coiiiiiiieiiie e et e et e ees 137
RESOUICE RAtE frOM PO .......e it e e e ees 137
ROIE DAta fTOM PB.......oeeeiiiee et 138
Create ROIE RAte frOM PO ........uoiiiiiiii e e 138
BUSINESS FIOWS iN GAEWAY ......cuvueiiiiieeiiieeeiee e e e e e e e e e e e e e 139
Get Resource and Role Rates from P6 ..........ooiviiiiiiiiiieeeeeeeeeee e 139
Synchronization: Resource and Role Rates from PG .................evvvieiiiiiiiiiiiiiiniiiinns 139

Gateway Data Dictionary

The following objects, in Gateway data dictionary, support the integration:

» PG6Resource

» PG6ResourceRate
» P6Role

» P6RoleRate

Each of these objects are explained in the following tables:
P6Resource

Note: P6Resource exists in Gateway only, and it is not deployed through

Unifier.

Field Type Description
uuu_resc_parent_id String Resource Parent ID
uuu_resc_short_name String Resource short name
uuu_resc_name String Resource Name
uuu_resc_status String Resource Status
uuu_resc_curr String Currency
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P6ResourceRate

Note: P6ResourceRate exists in Gateway only, and it is not deployed

through Unifier.

Field Type Description
ResourceObijectld Foreign Key Resource object ID to map
the rate

effective_date String effective date for the rate
standard_rate String price per unit

P6Role
Note: P6Role exists in Gateway only, and it is not deployed through
Unifier.
Field Type Description
uuu_role_parent_id String Role Parent ID
uuu_role_short_name String Role Code
uuu_role_name String Role Name
uuu_role_status String Role Status

P6RoleRate
Note: P6RoleRate exists in Gateway only, and it is not deployed through
Unifier.
Field Type Description
RoleObjectld Foreign Key Role object ID to map the

rate

standard_rate String price per unit

Gateway Field Mappings

The following out of the box (OOB) field mapping templates are in Gateway to support the

integration:
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. e . Gateway .
Mapping Type Flow Type Unifier Object Object P6 Object
Sync
Resource P6Resource
data from P6 Both Master Data (New) Resource Resource
for EVM
Create
Resource Create Master Data P6Resource |Resource Resource
Rate from P6 Rate (New) |Rate Rate
for EVM
Sync Role
data from P6 |Both Master Data I(Dl\?sv\(;)le Role Role
for EVM
Create Role
Rate from P6 | Create Master Data P6RoleRate Role Rate Role Rate
for EVM (New)

Resource Data from P6

A mapping template is created to map the fields of Resource object in P6 to P6Resource
object in Unifier. The following is used for creating/updating a new Rate Sheet:

Unifier Field Name Gateway Field Name P6 Field Name
uuu_resc_parent_id ParentObjectid ParentObjectld
uuu_resc_short_name Id Id
uuu_resc_name Name Name
uuu_resc_status IsActive IsActive
uuu_resc_curr CurrencyName CurrencyName

Resource Rate from P6

A mapping template is created to map the fields of Resource Rate object in P6 to

P6ResourceRate object in Unifier. The following is used for creating/updating a new Rate Sheet

in Unifier:
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Unifier Field Name

Gateway Field Name

P6 Field Name

ResourceObjectld

ResourceObjectld

ResourceObjectld

effective_date EffectiveDate EffectiveDate

standard_rate PricePerUnit PricePerUnit

Role Data from P6

A mapping template is created to map the fields of Roles object in P6 to P6Role object in
Unifier. The following is used for creating/updating a new Rate Sheet:

Unifier Field Name Gateway Field Name P6 Field Name
uuu_role_parent_id ParentObjectid ParentObjectld
uuu_role_short_name Id Id
uuu_role_name Name Name
uuu_role_status IsActive IsActive

Create Role Rate from P6

A mapping template is created to map the fields of Role Rate object in P6 to P6RoleRate
object in Unifier. The following is used for creating a new Role in the Rate Sheet:

P6 Field Name Gateway Field Name P6 Field Name
RoleObijectld RoleObijectld RoleObijectld
standard_rate PricePerUnit PricePerUnit

This mapping template contains the pre-defined elements of Unifier mapped to corresponding
fields in P6, but you can deploy additional custom attributes to Gateway (for Activity Sheet), and
they will be available for the data mapping templates.

For mandatory fields, the integration will fail if you change the data mapping template (or create
your own data mapping template) such that a mandatory element is no longer in the template
(that is, you remove a mandatory element from the mapping template).
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Note: The schedule type is a mandatory field while sending the data
across multiple P6 projects to Unifier.

Business Flows in Gateway

The following out of the box (OOB) Business Flows are available in Gateway:

Business Flow Field Mapping Template Description

(Applied for)
Get Resource and Role Sync Resource data from Create/Update Rate Sheets
Rates from P6 for EVM P6 for EVM (Both) from P6 to Unifier

Sync Resource Rate from
P6 for EVM (Create)

Sync Role data from P6 for
EVM (Both)

Sync Role Rate from P6 for
EVM (Create)

Get Resource and Role Rates from P6

This business flow is used to push Rates data from P6 to Unifier Company Workspace. The
business flow can be initiated from Unifier or Gateway. After it is initiated from either of these
applications, Gateway will have all the data from P6 and will send the data to Unifier Provider.
Unifier Provider then creates/updates the Master Rate Sheet in Unifier Company Workspace.

The following P6 parameters are enabled for this flow:

» Include resource hierarchy
» Include role hierarchy

The following parameter is enabled for this flow:
Delete data that no longer exists in the source application? (Default value = Yes)

Synchronization: Resource and Role Rates from P6

This synchronization is set:

» To be out-of-the-box (OOB) to be initiated from Unifier.
» To fetch the Resource and Role list from P6, along with the respective standard rate.

Only one Master Rate Sheet is allowed at the Company level in Unifier. If the Master Rate Sheet
does not exist, create one manually or use the Get Data option in the Master Rate Sheet log.

When the Master Rate Sheet exists, the fields values will be updated regularly with the latest
data from Gateway.
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Notes:

= |f a transaction fails because of connection issues with Gateway, or
incorrect Gateway parameters in Admin mode, it is recorded in the
job history with an error message.

= While only one Master Rate Sheet exists at the Company level, users
can create multiple Rate Sheets at the project/shell level.

= Resource and Role rates will be imported from P6 the first time a
Master Rate Sheet is synchronized. Subsequent imports will not
update the rates.
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The following sections provide details about the User Defined Report (UDRS).

Also see the Internationalization and CSV Files section for language (Internationalization)
details.

Designing Accessible Reports

Primavera Unifier provides the ability to build accessible report layouts. Reports and layouts are
created by users. As such, it is up to the users creating the reports to ensure that they are built
meeting accessibility criteria, if necessary.

In This Section

About User-Defined Reports (UDRS).......ccoiiiiiiiiiiii et eeeeans 141
Accessing User-Defined Reports (UDRS) .......coooiviiiiiiiiiiiieee 142
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Creating a User-Defined REPOIT ......coooiiiiiiiiie e 149
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Working with AUdit REPOITS ......oooiiiiiiiiiiiii 172

About User-Defined Reports (UDRS)

A User-defined report (UDR) is a customizable report that can be run at the project, shell,
program, and company level (user mode).

The information that can be included in a UDR can include:

Any business process data element (that is, fields found on the business process form)
Business process workflow information

System data elements (including company, project, shell, and user information)
Column headings from cost, funding, and schedule sheets

Cost sheet and work package data elements

Shell P6 Summary

The data source for creating a report using the Shell P6 Summary data type are: P6
Summary and Spread.

You can open the tables within the P6 Summary Sheets in Unifier for data views.

v v v v v Vv
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» Data views in published status

You can define as many different reports as you need and save them for other users to access
and run.

User-defined reports are defined the same way for the project, shell, program, and company
level. Only the query fields will vary from report to report.

You can run reports on cash flow curve values in either transaction or project currencies. The
UDR will show the values in the chosen currency, and it will display the exchange rate used for
the conversion between the transaction and project currency. You can also run Snapshot reports
in both currencies. All changes done in the UDR will be supported for Snapshot reports.

Accessing User-Defined Reports (UDRS)

User-defined reports (UDRS) are set up and run in User mode.
You can run UDRs at the:

Project level
Shell level
Program level

4

4

4

» Company level

To access project-level, shell-level, program-level, or company-level user-defined reports:
In User mode, Navigate to Reports > User-Defined. The User-Defined Reports log opens.

When you are running a report based on a permission-aware Document Manager data source,
the system lets you see the report only if you have permission to see the data source, in case of:

» Document Manager - Company
» Document Manager - Project/Shell
User-Defined Reports Log

The following table details the User-Defined Reports log:
Note: You will need specific permissions to use the following functions.

The User-Defined Reports log has the following toolbar options:
Create

Note: You need to have permission to create UDRs.

Enables you to select a source for your newly defined reports by providing the following
options:

» From System Data Sources

» From Permission Based Data Sources

» From Templates

The options above will be explained in subsequent sections.
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Actions

Enables you to perform the following functions on the selected report:

4

View

Transfer Ownership

Enables you to transfer the report ownership. Click the Select check box icon to open the
User Picker screen and select the user name.

Delete

Permissions

Enables you to open the Permissions window and do any of the following:
= View a list of users, groups, or both users and groups and their permissions.
*= Add, modify, or remove permissions.
= Add, modify, or remove users or groups.

When you are in the Permissions window, you can use the Next or Previous arrows icons
to move to the next or previous report and view the report permissions settings, users,
and groups.

Click Save to save your changes. Click Cancel to return to the log.

Similar to the View function of a BP, it enables you to set the view of the User-Defined
Reports log by using the following options:

4

4

4

4

All Reports
Owned by Me
Create new view
Manage Views

Edit View

Enables you to modify the user-defined view. You can use this option to modify the list of
available columns, apply filters, change grouping, or change sorting.

Refresh

Enables you to refresh the information displayed on the log.

Print

Enables you to print the contents of the log.

Find on Page

Enables you to find specific information on the log.

The User-Defined Reports log has the following columns:

Name

The name of the report.

Description

The description of the report, if available.

Data Type
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The report data type.
Access Type

The report access type.
Report Type

The report format type. By default, the Tabular option is selected. You can create and run
user-defined reports of the following types:

» Tabular: This is the basic report format, arranging information vertically in columns.
Tabular reports are a way to present related information for multiple records on the same
page.

» Cross tab: Cross tab reports allow the display of data on two axes and enable users to
run time-series reports defined by two data sources, for example, payments made per
quarter per vendor.

» Summary: Summary reports can be run to display summary data. Project-level summary
reports can also be used to customize the project summary page and include the
information that is most useful for you.

» Alert: Project- or shell-level alert reports are used to set up and customize system alerts
based on project- or shell-level triggers that you specify. For example, you have an alert
let you know when your remaining budget is getting low. Alerts are set up and
customized by users for their own use using alert reports.

Enable for Integration

Enables you the condition of the report, related to integration.
Owner

The owner of the report.
Last Run Date

The date the report was run the last time.
Creation Date

The creation date for the report.
Last Modified By

The person who modified the report the last time.
Last Modified Date

The date the report was modified the last time.
Schedule

The schedule that is set for the report to run.

The User-Defined Reports log reports have the following options for the gear menu ( & ):

» Run
» Copy
» Edit
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» Transfer Ownership
» Permissions
» Delete

Tabs

When you select a report, the User-Defined Reports log splits and displays the following report
properties tabs:

Saved Results tab
This tab provides the following information about the report, if available:
» Run Date
» Scheduled/Ad-Hoc
» Run By
» Output Format

Permissions tab

This tab provides permissions related information such as groups, users, and permissions
types.

Schedule tab
This tab provides information about:

» Scheduled report runs.
» Whether the report has been enabled to have scheduled Report runs.
» Output formats and scheduling frequencies

This tab also provides additional information about the report schedule, if any.

Use the Expand icon to expand the properties tab pane. Use the Collapse icon to collapse the
properties tab pane.

User-Defined Report Types

You can create and run user-defined reports of the following types:

Tabular: This is the basic report format, arranging information vertically in columns. Tabular
reports are a way to present related information for multiple records on the same page.

Cross tab: Cross tab reports allow the display of data on two axes. Cross tab reports enable
users to run time-series reports defined by two data sources, for example, payments made per
quarter per vendor.

Summary: Summary reports can be run to display summary data that can be used on
project/shell, program, and company Summary views.

Alert: Project/Shell-level alert reports are used to set up and customize the generation of system
alerts, based on a project/shell trigger that you specify. For example, you can have alerts let you
know when your remaining budget is getting low. Alerts are set up and customized by users for
their own use using alert reports.
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When creating a new user-defined report, the process is similar for all report types. The
Columns tab is the only tab that is different for each report type. Additionally, only Tabular
reports have a Group By and Sort By tab.

User-Defined Report Data Types

After choosing the report type (Tabular, Cross tab, Summary or Alert), you choose a data type.
This determines the type of data that will be displayed on the report.

Use for
Maintenanc
e
Manageme
nt Only

Project Shell UDR Program Company |[UDR

DataType | pRr UDR UDR Template

Accounts
Sheet

Active
Task X X X X
Information

Asset
Summary X
Sheet

Audit X X

Commitme
nt X X X
Summary

Company
Cash Flow

Company
Cost

Company
User X
Information

Cost Sheet
- CBS

Cost
Transactio |x X X X
ns -CBS

Cost
Transactio
ns MC -
CBS
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Data
Views

Document
Manager

Document
Manager—
Company

Equipment

Funding

Gates

Inventory

Inventory
On-hand
Detail

Iltem
Master

Job Plan

Master PM
Book

Master PM
Meter
Schedule

Master PM
Time
Schedule

Material
Transactio
n

Partner
User
Information

PM Book

PM Meter
Schedule

PM Time
Schedule

Program
Cash flow
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Program
Cost

Program
Schedule

Resource
Booking

Resource
Manager—
All Actuals

Resource
Manager—
Allocated
Roles

Resource
Manager—
Booked
Resources

Resource
Manager—
Project
Actuals

Resource

Manager -
Resources
(Company)

Resource
Manager—
Roles

Resource
Manager— | x
Sheets

Service
Center

Service
Request

Schedule
of Values

Shell or
Project X
Cash Flow

Shell or X
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Project
Cost

Shell or
Project
Groups

Shell or
Project
Information

Shell or
Project
Users

Workflow
Information

Work
Order

Work
Order
Iltems

Work
Order Role

(Asset
class
name)

(Business
process
name)

(Planning
type name)

Creating a User-Defined Report

To create a new user defined report:

1) Navigate to the Reports grouping node and click the User-Defined functional node. The

User-Defined Reports log opens.

2) From the top toolbar, click Create and select one of the following:

» From System Data Sources
» From Permission Based Data Sources
» From Templates

3) Fill out all tabs in the New User Defined Report window, and then select either Save Report

or Save Report & Run.
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See the following topics for more information about how to fill out each tab.

General Tab

The General tab allows you to input general information about the report, as well as select the
type of information that will be used as the basis of the report. It contains the following fields:

» Data Type: Select the type of data on which the report is being run. Data Type selected will
be locked for the report and cannot be reverted. This is a required field.

Report Name: This is a required field.

Report Type: This is a required field. It has the following options:

» Tabular

» Cross Tab

»  Summary

» Alert

See User-Defined Report Types (on page 145) for more information about each type.
Report Title

Element Type: The values in this dropdown menu are based on the data type selected. This
is a required field.

Description

Access Type

Report Owner

Enable for Integration.

Default Time Zone: Select the time zone that will be applied when the report is run.

Accessible: This option enables the manual report run results to meet accessibility
standards. When enabled, the output format is HTML, and the page layout will be portrait.
This option does not apply to scheduled report runs.

v v

v v v v v Vv

Note: You can only access the other tabs after the required fields of the
General tab are completed. After you move to another tab, the Data
Type, Report Type, and Element Type fields will become read only and
cannot be edited.

Columns Tab

The Columns tab allows you to define the structure of the report based on the different report
types.
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The image below displays the Columns tab for a Tabular report. Add columns to the report by
dragging and dropping data elements from the Available Columns list to the left pane. You can
drag multiple items at once by selecting the check boxes next to each item, then dragging one
selected item to the left pane.

The left pane header contains the following elements and columns:

» Add Formula
To add a custom column that is not listed in the Available Columns section. This is done by
creating a formula with other existing data elements.

For example: You can create a formula that subtracts a due date data element from a current
date data element to display how many days are left before the due date is reached, once
the report is generated.

» Refresh
To refresh the selected columns.
Data Element
Column Heading
Alignment
Width
Summary
Formula
Hide
Delete
To delete a column from the selected columns list.
» Reorder
To change the order of selected columns.

v vV v vV VvV vV v Vv
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The image below displays the Columns tab for a Cross tab report. The color of each block
corresponds to the picture in the top left block, to display how data is arranged. Select at least
one Data Element for the Body Columns, First Column, and Body Data blocks.

This is the Columns tab for a Summary report. The following fields are required:
» First Column

» Select Data Element for First Column

» Column Heading
» Second Column

» Column Type

» Column Heading

» Type

» Formula
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This is the Columns tab for a Alert report. Enter a formula for the report column.

Query Tab

The Query tab allows the entry of query parameters as defined during creation and setup. If the
report has been set up to enter query parameters, you may enter query information, which will
give report results based on records that match the parameters you entered, or you can run a
report on all records by leaving the field blank.

User-Defined Report (UDR) and Query-Based Tab

Users will be able to use the Summary Elements, from any of the QBTs, in any of the UDRs that
the user wants to use if the UDR is based on the same business process record.

The toolbar of the Query tab has the following elements:
» Add
» Refresh

» Filter
» Show results matching any of the following conditions

To add a query condition in the Query tab:

Click Add and select Query Condition based on Data Element or Query Condition based on
Formula.

» When selecting Query Condition Based on Data Element, the Add Data Element Query
Condition window opens and displays the following fields and elements:

» Data Element: The source of the data that will be used to create the query condition.
This is a required field.

» Label
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Condition: Defines how the data element will be checked, such as if the value of the
data element is equal to, less than, or greater than the specified value. This is a required
field.

Values: The values that are used by the Condition when checking the data element.
Allow users to modify value(s) during execution

Cancel

Save

Save & Add New

» When selecting Query Condition Based on Formula, the Add Formula Query Condition
window opens and the following fields and elements:

4

4

Formula Label: This is a required field.
Formula: To create a formula with multiple data elements when an existing data element
does not capture the desired value.

For example: You can create a formula that subtracts a due date data element from a
current date data element to represent how many days are left before the due date is
reached, and you can create a condition based on that value.

Condition: Defines how the formula will be checked, such as if the value of the formula is
equal to, less than, or greater than the specified value. This is a required field.

Values: The values that are used by the Condition when checking the data element.
Allow users to modify value(s) during execution

Cancel

Save

Save & Add New

Note: If you select the Allow users to modify value(s) during
execution option, the Allow Modify at Run column will contain a check
mark. You have the option to deselect the Allow users to modify
value(s) during execution option. However, the Allow Modify at Run
column will display a check box regardless of whether the box is
selected in the query condition (Add Data Element Query Condition).

The log of the Query tab displays the settings of each query condition, along with the actions
you can perform on each query condition. It contains the following columns:

VvV vV vV vV vV VvV v v Vv

4
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» Delete
To edit a previously added query condition, click the three dots in the Action column of the log
and click Open.

Note: You cannot open a previously added query condition by
double-clicking it in the log.

Group By and Sort By Tabs (Tabular Report Only)

Group By tab

The Group By tab allows you to create groups based on the selected columns. You can create a
max of three groups using the Add button.

The Group By log has the following columns:

Group By
Group Heading
Order

Delete

Reorder

v v v v Vv

After a group is added, you can edit the Group By and Order fields for that group by
double-clicking.

The right tab has the following additional options:

Show Group Header

Show Detail Rows

Show Summary Row in Footer
Show Group Name

Show Count in Footer

v v v v Vv

Sort By tab

The Sort By tab allows you to arrange the results in ascending or descending order, based on
the added columns.

Layout Tab

The Layout tab allows you to configure where the content of the report is displayed. It contains
the following elements:

» Paper Size

» Page Orientation
» Add

» Show Border
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Below the header options is a visual representation of how information will be organized when
the report is run. It contains the following columns:

» Left Column

» Center Column
» Right Column
» Row Height
» Delete
» Reorder

Each column contains cells that represent blocks of information. To add content to a cell, click
the Add button. The Page Layout window opens.

Select which section to add content to with the Select Layout for field, using one of the
following options:

» Title

» Header

» Footer

» Summary

Input a row height in the Select row height field.

You can select the content for the Left, Center, and Right columns, then select the Vertical
Alignment for each. Once finished, click Save.

Workspaces Tab

The Workspaces tab allows you to choose which shells to pull data from when the report is
generated. It contains the following options:

» Current Shell and Sub Shells

» Current Shell Only

» Sub Shells Only

» User-Defined

» Exclude Inactive Workspaces

If you select User-Defined, you can specify which shells will be used in the report generation.

Click Add and use the arrow buttons to move shells from the Available Workspaces list to the
Selected Workspaces list.

User-Defined Report Formats

You can choose the format of user-defined report results. The report format options are available
in the Query and Format section of the report at runtime.

The report format options are:

» HTML: Displays the report in the standard format in a browser window. You may print a copy
of the report from the browser window. (Right-click and select your browser's Print option)
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CSV: Formats the report in an exportable CSV format, usually in Microsoft Excel or another
software application you have set up for this format. You will be prompted to save the file or
open it.

Excel: Downloads the report in Microsoft Excel format. Depending on your browser, it will be
downloaded automatically, or you may be prompted to download or save it manually.

PDF: Displays the report as a PDF in a browser window. Depending on your browser, it will
be downloaded automatically, or you may be prompted to download or save it manually.
XML: Generates the output in XML format. Depending on your browser, it will be
downloaded automatically, or you may be prompted to download or save it manually.

If you want to save the report results in Unifier, select the Save results in Unifier check box in
the Report Location section of the report. Selecting this check box will save a copy of the PDF,
XML, or CSV report and make it available for retrieval.

Notes:

= Scheduled report runs can only be saved and retrieved in PDF, XML,
or CSV formats and sent to the report owner or to the owner and
other users and groups. These are chosen in the Schedule tab of the
Edit Report window.

= If you select a report format other than PDF, XML, or CSV, the Save
results in Unifier check box will be disabled.

= The DE of type Rich Text DE is not available to be added to the
User-Defined Reports (Reports > User Defined).

Running a User-Defined Report

Running a user-defined report consists of the following elements:

v v v v Vv

Define query parameters if applicable

Review/choose projects or shells to include if applicable
Add runtime notes if applicable

Choose the report format (HTML, CSV, Excel, PDF, XML)
Run the report

The following describes how to run project, shell, program, and company-level user-defined
reports.

Note: User-defined reports created with data view data types require the
data view to be in "published" status. If the data view was changed to
"draft" status, the report will not run, and you will see an alert.

To run a user-defined report

1) Open the shell, project, program, or company workspace.

2) Inthe left Navigator, click Reports > User-Defined.

3) Inthe User-Defined Reports log, double-click the applicable report or select it and then click

Gear menu > Run.
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4) In the report dialog box, select and enter values in the applicable values, which vary
depending on the report.

For more information, see the table below.
5) Click Run Report to generate the user-defined report.

Depending on your browser and your report format, the file will be downloaded automatically or
you will be prompted to download the file manually.

Query and Format

Report Format Choose the format in which the report
should appear: HTML, PDF, CSV, Excel,
or XML.

» HTML: Displays the report in the
standard format in a browser window.
You may print a copy of the report from
the browser window. (Right-click and
select your browser's Print option.)

» CSV: Formats the report in an
exportable CSV format, usually in
Microsoft Excel or another software
application you have set up for this
format. You will be prompted to save
the file or open it.

» Excel: Downloads the report in
Microsoft Excel format. Depending on
your browser, it will be downloaded
automatically, or you may be prompted
to download or save it manually.

» PDF: Displays the report as a PDF in a
browser window. Depending on your
browser, it will be downloaded
automatically, or you may be prompted
to download or save it manually.

» XML: Generates the output in XML
format. Depending on your browser, it
will be downloaded automatically, or
you may be prompted to download or
save it manually.
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Record count or UDR This option is available for Tabular,
Summary, and Cross Tab type reports.

You have ability to set the number of
records to be retrieved for the report. This
number will be set equal to the maximum
number set at the company level by
default, by the company administrator.

The maximum number will be divided into
intervals so that you can select the
appropriate number. Also, the numeric
format for the count must match your
preferences.

For more information, see the Options
Available for Record Count table.

Time Zone For information purposes, the Query tab
displays the time zone that is used for date
fields in the report. The default time zone
for a report is set up when the report is
designed. It can reflect your user time
zone, as defined in your user preferences,
or it can be fixed to a particular time zone,
such as the project location or company
headquarters.
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Report Query Parameters

If the report has been set up to enter query
parameters, you may enter query
information, which will give report results
based on records that match the
parameters you entered, or you can run a
report on all records by leaving the field
blank.

The query parameters are defined during
creation and set up. For example, you can
set up a report to list all leases that expire
within 10 days of today. You can also
choose to accept the default query
parameters, if any.

For program-level and company-level
UDRs you can see all projects and shells
with a status of Active, On-Hold, or
View-Only. You can specify which project
or shell the report should be saved in. For
shell-level reports only, you can choose to
exclude Inactive shells in the report run.

Depending on how the report was set up
(specifically, if "Allow users to modify
value(s) during execution" was enabled in
the creation step), you may add or remove
projects or shells as needed.

For shell-level (cross-shell) UDRs, you can
retrieve data across shells and sub-shells.

You can select to exclude inactive shells in
the report run, and the selection of shells is
determined when the UDR is created. You

cannot modify:

» Current Shell and sub-shells
» Current Shell only
» Sub-shells only

You cannot modify fields unless the fields
are set as user-defined. If the "Allow user
to modify User-defined list during
execution" check box was selected when
the UDR was created, then you can modify
the list of User Defined shells at run time of
the report by using the Add and Remove
buttons. You can only add the shells in
which you are a member user.
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Save Report Location

If you want to save the report, choose the
location it should be saved in:

» Save results in Unifier

This check box becomes active if you
select PDF, XML, or CSV. Selecting
this check box will save a copy of the
PDF, XML, or CSV report and make it
available for retrieval.

» Document Manager

Saves the report in the Document
Manager. If you choose this option, you
need to specify a name for the report
(Save As) and which folder of the
Document Manager it should be saved
in (Location).

Scheduled report runs can be saved and
retrieved in PDF, XML, or CSV formats
and sent to the report owner or to the
owner and other users and groups. These
are chosen in the Schedule tab of the Edit
Report window.
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Workspaces
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Workspaces The Workspaces block is for shell-level,
program-level, and company-level reports.
In the Workspaces block you can add
additional shells that the report can be
generated from.

When you run report, the Workspaces
block displays "User Defined" if you have
selected "User Defined" under the shells
tab in the report definition.

You can exclude Inactive Workspaces by
checking the check box, "Exclude Inactive
Workspaces," in the report definition.

The projects or shells tabs appear for

program-level and company-level UDRs
and shows all projects and shells with a
status of Active, On-Hold, or View-Only.

You cannot modify the list unless the
Workspaces block displays "User
Defined." All of the shells selected in

Edit report > Shells tab will be displayed in
Workspaces overlay (Available
Waorkspaces).

If the check box "Allow user to modify
User-defined list during execution" is
checked, then you can modify the list of
workspaces by using the Add or Delete
options.

When you click Add, a new Workspaces
Picker is displayed with both available and
selected workspaces (Selected
Workspaces section of the Workspaces
page). All of the shells that are already
added in the report definition are displayed
in the Selected Workspaces.

You can add additional Shells or remove
the existing ones in the Workspaces
Picker.

The Type field has the default value of
"All." The other options are all for active
shell types. You can filter shells by type.

The Find on Page option is available to
filter the available workspaces.

The Select option will add all the newly
added workspaces, as a part of filtered list,
while reporting.

The Cancel option will cancel the changes
and closes the window.

When in the report definition, under shells | 163
tab, any ofi the frollowing optionsr are
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Notes

Notes

Enables you to enter report notes that will
be included only on the current report
results (to be generated) and will not be
saved or generated in any subsequent
report results.

Options Available for Record Count

Max Limit at Company

Options available at Report level

100,000

1,000
10,000
25,000
50,000
75,000
100,000

250,000

1,000
50,000
100,000
150,000
200,000
250,000

500,000

1,000

100,000
150,000
200,000
250,000
500,000

750,000

1,000

100,000
150,000
250,000
500,000
750,000
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1,000,000 1,000
100,000
250,000
500,000
750,000
1,000,000

Retrieve scheduled report results

1) Navigate to the project-level, shell-level, program-level, or company-level User-Defined
Reports log.

2) Select a report from the log. The Saved Results tab opens in the right pane.

3) Double-click the saved result or click Gear menu > Download to view.

You will be prompted to open or save the results file.

Depending on your browser, the file will be downloaded automatically, or you will be prompted to
download the file manually.

To delete saved report results

1) Navigate to the project-level, shell-level, program-level, or company-level User-Defined
Reports log.

2) Select areport from the log. The Saved Results tab opens in the right pane.
3) Click Gear menu > Delete. Click Yes to confirm.

Save and Retrieve Scheduled Report Results

Report owners can schedule user-defined reports to run automatically and save the results as
PDF, XML, or CSV files. If you have run permission for a report, you can view or print any saved
results. Report owners can delete saved results from a scheduled report run.

You can save report results and query parameters on reports that you run manually (ad hoc).
This option is available only when the report is being generated in PDF, XML, or CSV format.
This is available at runtime for project-level, shell-level, program-level and company-level user
defined reports.

Note: The default time zone for a report is set up when the report is
designed. It can reflect the time zone of the person running the report, as
defined in user preferences, or it can be fixed to a particular time zone,
such as the project location or company headquarters. If the "user's time
zone" option was selected in the set up of this report, the time zone
reflected on the scheduled report results will be that of the report owner.

To save report results

1) Navigate to the project-level, shell-level, program-level, or company-level User-Defined
Reports log.
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2)

3)
4)
5)

6)
7)

To
1)

2)

3)
4)

5)

6)

To
1)

2)
3)

To
1)

2)
3)

Select a report from the log. The right pane displays results that have been saved from
manual (ad hoc) report runs as well as scheduled report runs.

Click the gear menu and click Run to open the User-defined Report window.
In the Query and Format section, choose PDF, XML, or CSV.

In the Report Location section, select the Save results in Unifier check box. This saves a
copy of the report results.

Click Run Report to run the report. This may take a few moments.

When the report is generated, you will be prompted with a download window for the report,
or it will be automatically downloaded to your system. The report will also be saved in the
Saved Results tab in the right pane.

save report results from scheduled report runs

Navigate to the project-level, shell-level, program-level, or company-level User-Defined
Reports log.

Select a report from the log. The right pane displays results that have been saved from
manual (ad hoc) report runs as well as scheduled report runs.

Click the Schedule tab in the right pane.

Select the Enable Scheduled Reports Run check box and select values for the Output
Format, Frequency, and Range of Recurrence fields.

In the Saved Report Location info section, select the location in which you would like to save
the reports that are generated according to the schedule.

If you select Saved Results log, the report results will appear in the Saved Results tab of
the report record.

If you select Document Manager, the report results will appear in the Document Manager.
Click Save when finished.

retrieve saved report results

Navigate to the project-level, shell-level, program-level, or company-level User-Defined
Reports log.

Select a report from the log and select the Saved Results tab in the right pane.
Double-click a saved result to download the report results to your system.

delete saved report results

Navigate to the project-level, shell-level, program-level, or company-level User-Defined
Reports log.

Select a report from the log and select the Saved Results tab in the right pane.
Click the gear menu next to the result and click Delete.

Print Report Results

After running a report, you can print a copy. Depending on the report format you chose, the
report results will be displayed in a browser window (HTML, XML), Adobe Acrobat Reader
(PDF), Excel (Excel, CSV), or other software application displaying CSV format. The printing
functionality will depend on the format of the report.
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To print report results
1) Run a user-defined reports (user defined reports).

2) For most formats, the file will be downloaded automatically, or you will be prompted to
download the file by your browser. For HTML and XML, you may need to right-click in the
browser pop-up window and choose Print. Additional printing functionality may be available
depending upon the report format.

Transferring Reports Between Environments

Multiple user-defined reports (UDRS) can be transferred between Unifier environments.

1) Goto Company Workspace > Admin mode > Configuration Package Management >
Component List.

2) Click Create.

3) Goto Company Workspace > User Defined Reports.

4) Select your reports.

5) Enter a value in the Name field (top left).

6) (Optional) Click Error Check to see if there are any dependencies.

7) Click Save.

Note: You can use the Save As option if you want to copy the
component list.

8) Goto Company Workspace > Admin mode > Configuration Package Management >
Configuration Packages (to create a configuration package).

9) Click Create.
10) Enter values in the Package Name, File name (zip file name), and Components Lists.
11) Select the component list related to your selected report.

12) In the New Configuration Package window click Next. The window displays a preview of
your reports.

13) Click Next. In case of errors, you will see messages, if no errors are detected, then respond
to the following:

» Do you want to publish this package for production?
» Download package after creation.
14) Click Create to create the configuration package.
15) Import the configuration package into the destination environment to transfer the reports.

Working with Custom Reports

If your company has custom report in a Program, Project, or Shell developed through BI
Publisher/Oracle Analytics Publisher, the custom reports will be available under the Custom
grouping node (User mode > Reports > Custom > [Report Name]).
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Note: You must have permission to access custom reports in User
mode.

To run a custom report in a Program, Project, or Shell:

1)
2)
3)

4)
5)
6)

Open the Program, Project, or Shell.
Switch to User mode.

In the Navigator, click Reports > Custom > [Report Name]. The Reports log shows the list
of available custom reports, if you have permission to access.

The Report Settings Page will open in the right pane.
In the Template and Format section, select an output format.

In the lower-right corner of the Report Page, click Run Report to generate the report in the
selected format.

Note: The print output is based on your permissions to certain data.

Report Settings Page

When you select the Report Name functional node, under the Custom grouping node in the left
Navigator, the Report Settings Page will open in the right pane.

The following explains the main elements of the Report Settings Page:

»

Name
The Report name appears in the upper-left corner of the page.
Template and Format

The Template field is a drop-down list that displays the default template that was used at the
time of designing the report in the Bl Publisher/Oracle Analytics Publisher. If multiple
templates are available for the External Report, they will be listed in this drop-down list.

The Format field is a drop-down list that displays the default format (set based on the default
template) that was used at the time of designing the report in the Bl Publisher/Oracle
Analytics Publisher. If multiple formats are available for the selected template, they will be
listed in this drop-down list.

Example

Available Template: Contracts

Available Formats: PDF, RTF
Search Parameters

This section contains all the parameters that are designed for the External Report in the Bl
Publisher/Oracle Analytics Publisher. Bl Publisher/Oracle Analytics Publisher supports the
following parameter data types:

»  String

» Integer
» Boolean
» Date

» Float
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Acceptable values (which include wildcard characters) for these parameters depend on the
data model used for the report definition.

Except for the Date parameter, the Reports Settings window displays a text field for the other
parameters.

Additional Parameters

Displays additional parameters as defined by the report.

Run Report

When you click Run Report, the system generates the report. When you run an External
Report in the User mode, the system accesses the Bl Publisher/Oracle Analytics Publisher
and the External Report output will be based on the latest design of the report in the Bl
Publisher/Oracle Analytics Publisher. Unifier does not store any data related to the External
Report content such as model, format, layout, and so forth.

Reset

When you modify the Template, Format, or Parameters fields, a Reset button will appear in
the lower-right corner of the Report Page. Clicking Reset will clear out all the entries made
by the user and will reset the fields back to the template default.

Custom grouping node

The Custom grouping node, under the Reports grouping node in the left Navigator, includes
both the Internal Reports and the External Reports.

When you select and open an Internal Report, the Internal Report log opens and contains the
following columns:

»

Name
Displays the name of the Internal Report that has been created.
ID

Displays the system-generated ID, for example, uuu_ext_54 for external report and uuu_54
for internal report.

When you select and open an External Report, the External Report log opens and contains the
following columns:

»

Report Name

Displays the name of the External Report that has been created in the Bl Publisher/Oracle
Analytics Publisher.

Default Template

Displays the default template name (for the Default Format) of the External Report that has
been set in the Bl Publisher/Oracle Analytics Publisher.

Default Format

Displays the default format of the External Report that has been created in the BI
Publisher/Oracle Analytics Publisher.
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Running an External Report

When you run an External Report in the User mode, the system accesses the BI
Publisher/Oracle Analytics Publisher and the External Report output will be based on the latest
design of the report in the Bl Publisher/Oracle Analytics Publisher. Unifier does not store any
data related to the External Report content such as model, format, layout, and so forth.

When you open an External Report, the Report Settings window opens, which contains fields
related to the External Report parameters (listed in the Parameters section of the window), and
fields related to the template and format for the External Report (Available Templates and
Available Formats). The User can set the External Report attributes in the Reports Settings
window.

Permission-Based User-Defined Reports (UDRS)

When you are creating User-Defined Reports (at Project/Shell, Program, and Company levels),
you have the option to create UDR with System Data Sources or with Permission Based Data
Sources.

Note: To be able to create the UDRs, you must have the Permissions
Create All, Create Permission Based, and Full Access permissions.

1) Go to Project/Shell, Program, or Company (User mode).
2) Click the Reports grouping node to expand it.
3) Click User-Defined functional sub-node.
4) Click Create and select one of the following:
» System Data Sources
» Permission Based Data Sources
If you select the System Data Sources option, you can use the Create a new report window to
create a UDR based on the following fields:
» Data Type
» Report Type
» Access Type (read-only)
If you select the Permission Based Data Sources option, the following data sources are
available to create permission-aware UDRSs:
» Business Process (BP)
» Document Manager

In the User-Defined Reports log, the Copy from Templates option (based on the report that is
selected) will create a copy of the report based on the existing functionality.

The above applies to when you have the Permissions Create Permission Based permission.

When only have the Create for Permission Based Data Sources permission, you have the
ability to create UDRs based on the permission aware data.
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When creating a new UDR by way of copying an existing one, if you select a System Access
Type report, the system does not allow you to create a UDR that is based on System Data
Sources and displays an alert.

The permission for permission-aware data sources for a report that is packaged will be
transferred from one environment to another.

Review the following for more information

When you are running report based on system-defined data sources, if your report is based on
system-defined data sources, then the report will contain the system-defined data irrespective of
your permissions. The same result will be applicable to the Schedule Reports.

When you are running report based on permission aware BP data sources, and the permission
aware reports are created based on BP data sources, then:

» The data presented in the report will be based on the permissions of the user who is running
the report, and the user will only be able to access the data that they have permissions to
see through the user interface.

» If you are running a permission based report, and you do not have access to the data for the
BP data source, then the report output will be blank.

» In case of Scheduled Reports, the data returned will be based on the permissions of the user
who is creating the report.

» The permission restriction is applicable only to the first level of data source.
Example
User One and User Two are Unifier users.

User One has permission to access the Meeting Minutes BP, but User Two does not have
permission to access the Meeting Minutes BP.

The Meeting Minutes BP log has a column that refers to an Action Items BP.
User One does not have permission to access the Action Items BP.

When User One creates and runs a report on the Meeting Minutes BP, User One will be able
to see the data related to Meeting Minutes BP as well as the column data which references
the Action Items BP.

When User Two creates and runs a report on the Meeting Minutes BP, User Two will see a
blank report.

» For a Company-level UDR, if the access permission to data goes across the projects, then
you will be able to view the data for BPs based on permission levels present for those BPs
across the projects.

When a user is running a report based on a permission aware Document Manager data source:

» When running such a report, the data presented in the report will be based on the
permissions of the user who is running the report. When present, the folder and document
level permissions will also be taken into consideration.

Transfer Ownership for UDRs

The administrator can define who has access to the UDR.
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At the Company Level as well as Project level, you can use the Transfer Ownership option (at
the log level) to change the owner of the UDR. This option will be available to change owner for
multiple reports at a given time.

1) Goto Company Workspace.

2) Click Reports to expand it.

3) Click User-Defined to open the User-Defined Reports log.

4) Select the reports the you want the owners changed.

5) Click Actions > Transfer Ownership to open the User/Group Picker window.

6) Select the new owner for the reports.

You can only select one user in the User/Group Picker window.
The list of users that you see contains the users who have access to the Project/Shell.
The user must have Full access permissions.

When editing, you can change the owner of a report by way of the Report Owner field in
General tab.

After the owner for the report is changed, the Permission tab in the UDR displays the new
changed owner with all permissions for that report. For example, if the ownership for report R1
was changed from A-user to B-user, then the Permission tab displays B-user, only (with full
owner permission), and the A-user will not be seen in the Permission tab.

Working with Audit Reports

If your company has custom report in a Program, Project, or Shell, it will be available under the
System grouping node (User mode > Reports > System > Audit).

Note: You must have permission to access custom reports in User
mode.

To run a custom report in a Program, Project, or Shell:

1) Open the Program, Project, or Shell.

2) Switch to User mode.

3) Inthe Navigator, click Reports > System > Audit.

4) The Audit Report Page will open in the right pane.

5) Define query parameters if applicable.

6) In the lower-right corner of the Report Page, click Run Report to generate the report in PDF

format.
Audit Report Page

When you select the Audit functional node, under the System grouping node in the left
Navigator, the Audit Report Page will open in the right pane.

The following explains the main elements of the Audit Report Page:
» Audit Summary Report Query
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This section contains all the query parameters that are designed for the Audit Report. You may
enter query information, which will give report results based on records that match the
parameters you entered, or you can run a report on all records by leaving the fields blank. The
following query parameters will be visible:

» Description contains
» Event Name containsr
» From (Company)
» From (User)
» From
» To
» Sort by
» Order
» Run Report
When you click Run Report, the system generates the report in PDF format.

» Reset
When you modify the query parameters, a Reset button will appear in the lower-right corner
of the Report Page. Clicking Reset will clear out all the entries made by the user and will
reset the fields back to the template default.
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Unifier Mobile Application for iOS or Android

If your company employees are often out of the office, Unifier can keep the workflow moving by
using the Oracle Primavera Unifier Mobile Application. The Unifier Mobile App is built specifically
for installation and use on mobile devices that use iOS or Android operating system.

By using the Unifier Mobile App you can:

» Act on the assigned tasks.

» View the various tasks.

» Create new business process records.
» Work offline.

To get the Unifier Mobile App, you have the following options:

» Download it from App Store or Play Store, or

» Launch Unifier, click your user name in the upper-right corner, click Get Unifier Mobile App,
and follow the prompts.

After download, you can scan the QR code to set up the Server URL and user name on your
Unifier Mobile App.

Notes:

= If you are in a region without access to the Google Play Store, Apple
App Store, or your organization is using a Content Security Service
or Mobile Device Management solution and requires that users do
not download from the Apple Store or Play Store, submit a Service
Request in My Oracle Support to request versions of the Unifier
Mobile Application for those scenarios.

= [f your iOS device does not have the Passcode feature enabled, you
can download and install the mobile application; however, the system
displays a message that indicates you must go to Settings and
enable the Passcode feature before you can use the application.

= If your iOS device is jailbroken (lacks the manufacturer's restriction
that prevents installation of unauthorized software), you can
download and install the mobile application; however, the system
displays a message that you cannot use it with a jailbroken device.

In This Section
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Business Processes

The following Business Processes (BPs) can be accessed through the mobile app:
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» BPs used by field employees to record, or gather, data.
» Cost Type BPs used by executives, or approvers.
» BPs that require action.

For a BP to be accessed through the Unifier Mobile app, the following conditions must be
present:

» The BP must be enabled for mobile application (Enable for Mobile Application) in the
configuration window (General tab), in the business process configuration

» The forms, seen in the mobile app, are the forms designed in uDesigner.
The following BPs are not currently supported for use with Unifier Mobile App:

Lease

Line Item with CBS and WBS Codes
Payment Application

Project/Shell Creation

Request for Bid (RFB)

Reservation

Resource Booking

» Timesheet

v v v v vV v Vv

Important!

The mobile app does not rely on the Enable design for Mobile Form Factor check box option
that was set in uDesigner. The Enable for Mobile Application must be checked in the Business
Process configuration window. The uDesigner option will only control the forms seen in the
mobile app (standard form as opposed to mobile form factor forms).

The setting of this option will be exported to the created Configuration Package (Company
Workspace, Shell template, and so forth).

You cannot view data related to Business Processes, and assigned tasks, without proper Unifier
Mobile App configuration. Before you download the Unifier Mobile App, contact your Company
Administrator and verify that the required setup has been done.

Data Type and Input Type

The following data and input types are supported in the mobile app:

Data Type Input Type
Checkbox Integer

Currency Float

Multi Select Input String

Multi Test Lines String

Picker String, Date, Integer
Pull Down Menu String, Integer
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Data Type Input Type
Radio buttons String, Integer
Text Box String

Date picker String
Pickers

The following pickers are supported in both the iOS and Android Unifier mobile apps:

Picker Single/Multi select
BP Picker Single select
User Data Picker Single select
CBS Picker Single select
Data Picker Single select
BP Line Item Picker Single select
Configurable Manager Picker (CMx Picker) | Single select
Generic Cost Picker (CMO Picker) Single select
User Picker Single select
Image Picker Single select

User Identity

If Unifier has been configured to sign in users using single sign-on (SSO), then the Sign In
window will not appear on your device screen. In addition:

» The application does not capture the user's username and password.

» The user's first name, last name, and email address are all stored in Unifier database, but
they are not shared with any other applications, including third-party applications.

If Unifier has been configured to sign in users using basic authentication, then the Sign In
window will appear on your device screen. In addition:

» Unifier captures the user's username, password, first name, last name, and email address.

» The user's username, password, first name, last name, and email address are stored in a
shared object that uses encrypted format, and they are not shared with any other
applications, including third-party applications.
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